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eASCTrend License Agreement 
 

Important: One license of eASCTrend (the "PRODUCT") can work only at one specific time. You cannot run one license of 
eASCTrend with two computers simultaneously. If you did not order the Broker or Institutional multi-user license, you may 
not use this software to trade other people's accounts or an institutional account.  

 
THE PRODUCT IS PROVIDED "AS IS." THE PURCHASE AND LEASE OF THE PRODUCT ARE NON-REFUNDABLE. I 
RECOGNIZE THAT HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN INHERENT 
LIMITATIONS, UNLIKE AN ACTUAL PERFORMANCE TRADING. ALSO SINCE THE TRADES HAVE NOT ACTUALLY 
BEEN EXECUTED, THE RESULTS MAY HAVE UNDER- OR OVER-COMPENSATED FOR THE IMPACT, IF ANY, OF 
CERTAIN MARKET FACTORS SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL ARE 
ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO 
REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFITS OR LOSSES 
SIMILAR TO THOSE SHOWN. I UNDERSTAND THAT THERE IS SUBSTANTIAL RISK OF LOSS TRADING STOCKS OR 
COMMODITIES WITH OR WITHOUT THIS PRODUCT. ABLESYS CORPORATION CANNOT AND WILL NOT 
GUARANTEE PROFITS IN TRADING MARKETS. 

 
AbleSys Corporation makes no warranty or representation, either express or implied, with respect to this software, the 
hardware, or documentation, including its quality, performance, merchantability, or fitness for a particular purpose. 

 
ASC WARRANTS THAT THE SOFTWARE CD IS FREE FROM DEFECTS IN MATERIALS AND WORKMANSHIP 
UNDER NORMAL USE FOR A PERIOD OF THIRTY (30) DAYS AFTER RECEIPT, AND ANY IMPLIED 
WARRANTIES ON THE DISKS ARE LIMITED TO THIRTY (30) DAYS. CERTAIN STATES DO NOT ALLOW 
LIMITATIONS ON DURATION OF AN IMPLIED WARRANTY, SO THE ABOVE LIMITATION MAY NOT APPLY 
TO YOU. ASC’s ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY TO THE DISKS SHALL BE 
REPLACEMENT OF THE DISKS THAT DO NOT MEET THIS LIMITED WARRANTY. YOUR FREE TECHNICAL 
SUPPORT IS LIMITED TO THIRTY (30) DAYS FROM THE PURCHASING TIME. 

 
Because software is inherently complex and may not be completely free of errors, you are advised to verify your work. In no 
event will AbleSys Corporation be liable for direct, indirect, special, incidental, or consequential damages arising out of the 
use of or inability to use the software, hardware, or documentation, even when user has been advised of the possibility of 
such damages. In particular, AbleSys Corporation is not responsible for any costs, including, but not limited to, those 
incurred as a result of the use of the software, loss of data, the costs of recovering such software or data, the cost of 
substitute software, claims by third parties, or for other similar costs. In no case shall AbleSys Corporation's liability exceed 
the amount of the license fee. 

 
The warranties and remedies set forth above are exclusive and in lieu of all others, oral or written, express or implied. No 
AbleSys Corporation dealer, distributor, agent, or employee is authorized to make any modification or addition to this 
warranty. 

 
Some states do not allow the exclusion or limitation of implied warranties or limitation of liability for the incidental or 
consequential damages, so the above limitation or exclusions may not apply to you. 

 
GENERAL 

 
AbleSys Corporation retains all rights not expressly granted. Nothing in this license constitutes a waiver of AbleSys's rights 
under the United States copyright laws or any other federal or state law. 
 
IMPORTANT DISCLAIMER: ALTHOUGH WE BELIEVE THE INFORMATION AND THE DATA PRESENTED ARE 
ACCURATE, ABLESYS CORPORATION AND THE DEVELOPER NEITHER GUARANTEE THEIR ACCURACY 
NOR ASSUME ANY LIABILITY. PAST PERFORMANCE IS NOT A GUARANTEE OF FUTURE RESULTS. 
HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN INHERENT LIMITATIONS. 
UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT REPRESENT ACTUAL 
TRADING. NO ASSUMPTION SHOULD BE MADE THAT ANY ACCOUNT WILL ACHIEVE PROFITS OR LOSSES 
THE SAME AS THOSE SHOWN. 

 
Should you have any questions regarding this license, please write to AbleSys Corporation at 20954 Corsair Blvd., 
Hayward, California 94545. 
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DISCLAIMER 
 

THE FOLLOWING INFORMATION, DISCLOSURE, AND DISCLAIMER ARE APPLICABLE TO ALL PRODUCTS 
MARKETED BY ABLESYS CORPORATION (ASC). THE “PRODUCTS” WILL ALSO INCLUDE ANY ADDITIONS, 
REVISIONS, OR ADDENDUMS TO THE CURRENT PRODUCTS. 
 
THE INFORMATION PRESENTED IN THIS MANUAL IS CONFIDENTIAL AND IS THE PROPERTY OF ABLESYS 
CORPORATION. THIS INFORMATION CANNOT BE USED, DISCLOSED, OR DUPLICATED WITHOUT PRIOR 
WRITTEN CONSENT OF ABLESYS CORPORATION. THIS IS AN UNPUBLISHED WORK PROTECTED BY THE 
FEDERAL COPYRIGHT LAWS AND NO UNAUTHORIZED COPYING, ADAPTATION, OR DISTRIBUTION IS 
PERMITTED. 
 
THIS PRODUCT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. YOU ASSUME THE ENTIRE RISK OF 
THE PRODUCT. ALSO YOU ASSUME THE RISK ASSOCIATED WITH THE RESULTS AND PERFORMANCE OF THE 
PRODUCT. ASC WARRANTS THAT THE DISKS ARE FREE FROM DEFECTS IN MATERIALS AND WORKMANSHIP 
UNDER NORMAL USE FOR A PERIOD OF THIRTY (30) DAYS AFTER RECEIPT, AND ANY IMPLIED WARRANTIES 
ON THE DISKS ARE LIMITED TO THIRTY (30) DAYS. CERTAIN STATES DO NOT ALLOW LIMITATIONS ON 
DURATION OF AN IMPLIED WARRANTY, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. ASC’S ENTIRE 
LIABILITY AND YOUR EXCLUSIVE REMEDY TO THE DISKS SHALL BE REPLACEMENT OF THE DISKS THAT DO 
NOT MEET THIS LIMITED WARRANTY. 
 
HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN INHERENT LIMITATIONS. UNLIKE 
AN ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO 
SINCE THE TRADES HAVE NOT ACTUALLY BEEN EXECUTED, THE RESULTS MAY HAVE UNDER- OR OVER-
COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN MARKET FACTORS SUCH AS LACK OF LIQUIDITY. 
SIMULATED TRADING PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED 
WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR IS 
LIKELY TO ACHIEVE PROFITS OR LOSSES SIMILAR TO THOSE SHOWN. I UNDERSTAND THAT THERE IS 
SUBSTANTIAL RISK OF LOSS TRADING STOCKS OR COMMODITIES WITH OR WITHOUT THIS PRODUCT. ASC 
CANNOT AND WILL NOT GUARANTEE PROFITS IN TRADING MARKETS. ALL TRADING DECISIONS OF ANY 
INDIVIDUAL REMAIN THE SOLE RESPONSIBILITY OF THAT INDIVIDUAL. ASC SHALL BE HELD WITHOUT 
LIABILITY FOR ANY TRADING LOSSES, WHICH MAY OCCUR DUE TO THE USE OF THE PRODUCTS. 
 
NEITHER ASC NOR ANY OF ITS OFFICERS, DIRECTORS, EMPLOYEES, OR AGENTS SHALL BE LIABLE FOR ANY 
LOSSES, DAMAGES, COSTS, OR EXPENSES (INCLUDING BUT NOT LIMITED TO LOSS OF PROFITS, DIRECT, 
INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES) ARISING FROM OR RELATING TO THE USE OF THE 
PRODUCT, REGARDLESS OF WHETHER A CLAIM ARISES IN CONTRACT, TORT, NEGLIGENCE, STRICT LIABILITY, 
OR OTHERWISE. ASC’S LIABILITY UNDER THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT I HAVE PAID 
ASC FOR THE PRODUCT.  
  
THERE ARE NO EXPRESS OR IMPLIED WARRANTIES OR REPRESENTATIONS PROVIDED BY ASC OR ITS 
OFFICERS, DIRECTORS, EMPLOYEES OR AGENTS, INCLUDING BUT NOT LIMITED TO WARRANTIES OF 
MERCHANTABILITY AND WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE OR USE. 
 
I HEREBY AGREE TO HOLD HARMLESS AND INDEMNIFY ASC AND ITS OFFICERS, DIRECTORS, EMPLOYEES AND 
AGENTS FROM AND AGAINST ANY AND ALL LOSSES, COSTS, DAMAGES, AND LIABILITIES, INCLUDING 
REASONABLE ATTORNEYS’ FEES AND EXPENSES, RESULTING DIRECTLY OR INDIRECTLY FROM THE USE OF 
THE PRODUCT BY ME OR MY EMPLOYEES OR AGENTS, OR ANY CLAIMS BROUGHT AGAINST ASC THAT ARISE 
OUT OF OR RELATE TO THE USE OF THE PRODUCT BY ME OR MY EMPLOYEES OR AGENTS. 
 
ANY DISPUTE ARISING OUT OF OR RELATING TO THIS AGREEMENT OR THE PRODUCT, OR TO THE BREACH OF 
THIS AGREEMENT SHALL BE SETTLED BY ARBITRATION ADMINISTERED BY THE AMERICAN ARBITRATION 
ASSOCIATION UNDER ITS COMMERCIAL ARBITRATION RULES, AND JUDGMENT ON THE AWARD RENDERED 
BY THE ARBITRATOR(S) MAY BE ENTERED IN ANY COURT HAVING JURISDICTION THEREOF. 
 
ASC BELIEVES THAT THE INFORMATION CONTAINED HEREIN AND DESCRIBED IN THIS MANUAL IS ACCURATE 
AND RELIABLE. HOWEVER, NO RESPONSIBILITY, FINANCIAL OR OTHERWISE, SHALL BE ACCEPTED FOR ANY 
CONSEQUENCES ARISING FROM THE USE OF THIS PRODUCT. INFORMATION CONTAINED HEREIN IS SUBJECT 
TO CHANGE. 
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Introduction 
Welcome to eASCTrend 6.0, the award-winning trading tool from AbleSys Corporation. This 
time-tested market analysis program works with a broad range of financial instruments, 
providing invaluable trading assistance wherever chartable price data is available. 
 
Your first step in initiating a trade is to select the specific stocks, futures, bonds, or Forex 
markets that you wish to follow. After you’ve made your selection and entered its parameters 
into our system, eASCTrend 6.0 analyzes the chart of the market for you, follows developing 
price action, and alerts you when it is time to enter and exit your trades based on its 
proprietary formulas. This remarkable program takes most of the guesswork and emotion out 
of your trading decisions. It even gives you the option to follow our trading signals 
completely mechanically, or adjust your decisions based on your own trading experience.  
 
Once you learn certain basics, it’s easy to use eASCTrend 6.0.This Manual provides a broad 
overview of the system, from initial set up through working with charts, using your trading 
tools, and trading strategy. If you have questions that are not answered here, our online Help 
feature is a great resource, or you can e-mail us at support@ablesys.com , or call 1-888-272-
1688 to speak with an AbleSys software consultant.  
 

Part One - eASCTrend 6.0 – Basic Operation 
 

In this section we’ll look at the basics of setting up price charts according to your 
preferences, applying eASCTrend indicators, setting up alerts, and using our other helpful 
features. In Parts Two and Three we’ll look at two different strategies you can use when 
trading with eASCTrend: the Hybrid Trading Method (HTM) and the Mechanical 
Trading System. 
 
So, let’s get started!  
 
To access the eASCTrend 6.0 tools, your computer system must meet certain basic 
requirements. You must also load our proprietary software onto your system, and, depending 
on the frequency of data you require (i.e., whether you day trade or position trade), you must 
have access to one or more data feeds to provide end of day and/or real-time market price 
information. System requirements and instructions are provided below. 
  
A. Computer and Data Feed Needs  

Computer System Requirements 
Windows XP, 2000, Me, 98, or NT 4.0 (service pack 3 or higher)  
233 MHz Pentium or compatible 
128 MB RAM 
20 MB available disk space 
28.8K modem or faster (cable, DSL, etc.) 
Internet Service Provider (ISP) 
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Microsoft Internet Explorer browser version 6.0 or higher 
Data Feed access (see section on data modules below)  
Suggested minimum screen resolution of 1024 x 768 or above 
Sound card and speakers for sound alerts 

Data Feed Modules 
ABLESYS_EOD/EOD2 are included in your subscription to provide end of day data. 
If you plan to do intraday trading, you must make your own arrangements to access 
another data feed provider that offers updated price data throughout the trading day. 
eASCTrend software supports eSignal data (you may choose Real-time, 15-minute 
Delayed or End-of-Day data), IQFeed, RealTick, or text files (from CSI Data).  
 
Before installing eASCTrend, please make sure that your data provider software is 
installed and running properly.  
 

B. Getting Started with eASCTrend 6.0 

Internet Connection 
To install our software, you must first have an Internet connection established. If you 
already have an Internet connection set up at your computer because you are on cable 
or DSL, you may skip this part. Otherwise, if you are on dial up, use WinXP, 
Win2000, WinNT, WinMe, or Win98 to set up Dial-Up Networking procedures:  

1. Double click the My Computer icon on your computer desktop. It will bring 
you to the My Computer window. Click the View menu and choose Large 
Icons … 

2. Double click the Dial-Up Networking icon. 
3. Double click the Make New Connection icon. The Make New Connection 

dialog box pops up. Follow the online instructions to input the required 
information. 

4. Input Computer Name and choose a Modem or Device, then click the Next 
button. 

5. Input your local Internet connection Phone Number … 
6. Click Finish. You are now ready to make the connection. When you double-

click the newly created connection icon, the Internet connection will launch. 
7. You are requested to input User Name and Password. 
8. Check the box for Save password. 
9. Check the Dial Properties … button on your phone line information. 
10. Double-click Connect to start the dial-up process for your Internet 

connection. 
11. For your convenience, you can make a copy of the Internet Dial-Up icon and 

place it on your desktop. Highlight (one click) the icon; then right-click and 
choose the Create Shortcut menu. It will ask you to make a copy to your 
desktop. 
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Installation and Setup of eASCTrend 6.0 Software 
  

With your Internet connection established,  you’re ready to install your eASCTrend 
6.0 software. Please read the License Agreement before opening the installation 
program. Then, load the program using the following procedure: 

1. Close all Windows applications and run your Internet browser. 
2. Go to www.ablesys.com on the Internet. 
3. Click on Download at the top of our home page and select eASCTrend 6.0. 
4. Use your ID and password (you can find them in the confirmation e-mail you 

received from us) to log in to the download section. 
5. Select the data module that you will be using.  
6. Download and install your data feed if you have not already done so. It isn’t 

necessary that you have your data feed username and password in order to 
download and install the data feed software. You can input your data feed 
username and password later.You may skip the data feed software download 
if you have already installed your data feed. 

7. Click eASCTrend 6.0 download to start the one-click installation. 
 

IMPORTANT: You can install eASCTrend 6.0 on multiple computers. But one 
license of eASCTrend will work at only one computer at a time.  
 

Start eASCTrend 

Click  , the AbleSys icon, on your desktop; or click the Windows Start button > 
Programs > AbleSys Corporation > eASCTrend60 > eASCTrend 6.0 to launch 
the software. 

 
(If you have problems launching the program remember the following: Before 
starting eASCTrend, you must have your Internet connection established. And, if you 
are planning to use a data service such as IQFeed, RealTick or eSignal, the software 
from your data provider must be installed. You may run eASCTrend alone or you 
may have the option to run both eASCTrend and software from your data 
provider at the same time.) 

 
When you start up eASCTrend software for the first time, a Login window will pop 
up.  

 
• On the AbleSys side of the window enter the full e-mail address, password and 

serial number from your AbleSys Web site registration. 
• On the Data Feed side of the window, select the appropriate Data Module; input 

data feed username and password. (If you are using AbleSys_EOD you do not 
need an outside data feed, and you may enter anything for the 
username/password, or even leave them blank.)  

Change Password  
If you wish to change your password, click Tools > Change Password. 
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Data Feed Indication 
Once you are logged in to eASCTrend, a series of lights appears in a Status Bar at 
the bottom of the screen. Data reception from both eASCTrend and your real-time 
data provider are tracked on this Status Bar to keep you informed of the status of 
your connection to AbleSys and to your data feed.  
 
Depending on the type and number of data feeds you have access to, you can expect a 
specific configuration of red and green lights on the Status Bar as outlined below: 
 

AbleSys Software 
version 

Data Feed Expected light pattern at the 
bottom of your screen 

eASCTrend Real Time eSignal, IQFeed, or Real 
Tick 

 

eASCTrend End of Day eSignal, IQFeed, or Real 
Tick 

 

eASCTrend End of Day AbleSys_EOD or 
AbleSys_EOD2 

 

 
 

• GREEN means the connection is healthy;  
• RED or YELLOW means there is a problem;  
• ABLE is the AbleSys server;  
• HIST is your data provider’s historical server;  
• TIC is your data provider’s tick history server; and 
• DM is your data provider’s real-time server. 
 
The pattern of lights can be used to help you identify the source of any problems. 
If you see yellow lights that do not turn green, as in this sample pattern: 

 , you are experiencing a problem accessing one or more 
of the servers. Most likely this is because you didn't input the correct data 
provider username or password (these are both case sensitive). 
 
When you first start up eASCTrend, there may be a short period of time during 
which the status appears as red while the software on your computer connects 
with the software servers on the Internet.  
If you don’t see the above lights at all, we suggest that you close eASCTrend 6.0 
and start your data feed first; also, make sure your Internet connection, password, 
and data reception are good. If you continue to have problems, go to the online 
FAQs and do a keyword search for “lights.” 
 
You can turn the Status Bar on or off by clicking on View in the menubar, and 
then clicking on Status Bar. 
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Data Feed Servers  
The History Server (HIST) provides historical daily, weekly, and monthly data which 
is used to create bars on charts on an end-of-day basis.  
 
The Tick Server (TIC) provides two types of data: intraday bar data and tick data. 
Intraday bar data includes open, high, low, close, and volume data for a period of 
time specified in minutes. Tick data includes the price and the number of shares sold 
as well as one record for each trade, which can amount to a large amount of data for 
volatile stocks.  
 
The Data Manager (DM) provides real-time streaming data of various kinds, 
including a record for every tick and every bid.  
 
Daily, weekly and monthly price charts use data from HIST supplemented by real-
time data from DM (for users who subscribe to an outside data feed). Generally, 
HIST provides data up to the close of the previous day, while the DM fills in the 
current day information. 
 
Intraday interval charts use historical bar data from TIC plus real-time data from DM 
to build the chart throughout the day. Accumulation of data into bars is done on the 
server, so that as the specified time interval gets longer, the volume of data 
downloaded is reduced. Please also note that the real-time price fluctuation 
information gets lost during the accumulation process. 
 
Tick bar charts use historical tick data from TIC plus real-time data from DM. 
Regardless of the specified number of ticks per bar, every tick for the required period 
is downloaded. This is because accumulation of ticks into tick bars is not a feature of 
TIC. Since the raw tick data is downloaded when the tick bar charts are plotted, to 
keep the chart size manageable, subscribers who use this feature should shorten the 

date range in the Format Active Symbol Window (accessed by clicking on the  
icon in the toolbar) to only one or two days. This will minimize the raw tick data 
download. 

 

More About Data Feeds Supported by eASCTrend 6.0 
As indicated earlier, eASCTrend supports the following data feeds: eSignal, 
RealTick, and IQFeed. Additional data feeds will be available in the future.  
 
ABLESYS_EOD and ABLESYS_EOD2 are included free of charge with your 
subscription.  
 
Text file data can also be used. When using text file data, you may import and export 
ASCII Data files (Text data format) through the File menu (in the menubar above 

each chart window) or by right-clicking your mouse and then clicking on the  icon 

that appears in the resulting menu. Or, you may click on the  icon in the toolbar 

© Copyright 2000-2006 by AbleSys Corporation. All rights reserved. 5 



above each chart window. Either way, you will be taken to the Format Active 
Symbol Window dialog box. Click on File under Interval, then click on the  
button to the right to import an ASCII format text data file to plot a chart. Note that 
both the Date Range and the Trading Times will limit data shown in the chart.  

 

Change Data Feed Module 
If you wish to switch your data feed module selection because you have subscribed to 
or unsubscribed from a data feed provider, you can only do this when you restart 
eASCTrend 6.0. The Data Module selection is only available in the Login window.  
 
If you previously checked Don’t show this dialog again in the Login window, you 
will not be able to see the Login window during restart. In this case, you need to 
uncheck this option first (Click the Tools menu in the menubar above the chart 
window; select Change Password), and then restart the program to see the Login 
window at launch time. 

 

Two Important Items 

The many helpful tools and features of eASCTrend can be easily accessed through 
the menubar and the toolbar located above the chart window. Once you learn how to 
use these, you will find it easy to navigate through the program and work with your 
charts. All that’s required is a little practice.  
 
THE MENUBAR: 
 

 
 
THE TOOLBAR: 
 

 
 
 
The best way to learn eASCTrend 6.0 quickly: 
 
1. Click each and every item within the menubar and toolbar. As different menus 

and dialog boxes appear, you will become familiar with the functions and actions 
associated with each item. 

 
2. Click Help on the program menubar to start online Help if you need more details 

about any of features on the menubar and toolbar.  
 

In this Manual we will examine in detail most of the items located in the menubar and 
toolbar. Keep eASCTrend open on your computer as you read, and follow the 
directions in each section. You will soon become comfortable with all that 
eASCTrend has to offer. 
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C. Working with Charts 
 

With eASCTrend, you can pull up any price chart on your computer by opening it in a 
workspace. You can then save your workspaces to set up your own online portfolio of 
charts for the markets you’re following. You can have up to eight workspaces, and each 
workspace can hold up to ten charts. 
 
Once your portfolio of workspaces is set up, you can easily refer to your charts to check 
their progress throughout the trading day. Saved charts will update according to the type 
of data feed you have access to. It’s also easy to add and delete charts from your 
portfolio. 
 
Let’s look at the simple steps required to manage your charts and customize their 
appearance to meet your own needs and preferences. 
 

Insert a Chart 
You can insert a new chart into a workspace in three ways: (1) in the menubar click 
on File > New Window > Chart Window, (2) in the menubar click on Insert, or (3) 
use the shortcut keys, Ctrl-N. Any of these methods will bring up an Insert Symbol 
dialog box in which you are asked to enter the trading symbol for the market you 
wish to chart. In this window you can also specify certain appearance characteristics 
for your chart as well as its time interval (e.g., daily or weekly). 
 
It’s easy to find the trading symbol for your market by referring to the resources on 
our Web site. Simply go to the AbleSys.com homepage and log in. Once you are 
logged in, click on the eASCTrend 6.0 Support link in the Support box just below 
the tabs. In the window that appears next, scroll down to the list of Easy References 
and then click on the eSignal Symbol Guide link. You can also access this area by 
clicking on Help in the menubar while you are inside the eASCTrend 6.0 program, 
and then selecting Support.  
 

Format a Chart 
You can customize the appearance of any chart to suit your needs and preferences. 
Initially, all newly created charts display the attributes of our default global chart 
format. You can make changes to the global chart format, and thereafter all the 
attributes you specify will take effect when you re-open your saved charts or 
workspaces, or open new ones. 

To format any chart, follow this procedure: 

1. Click Format in the menubar. 
2. Click Chart to begin formatting the chart. 
3. Using the Chart Format dialog box that pops up, you may format the following 

chart attributes:  
• Axis Line color. Click the color drop-down list to format the colors. 
• Grid Line color. Click the color drop-down list to format the colors. 
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• Background color. Click the color drop-down list to format the color. 
• Splitter Bar color. Click the color drop-down list to format the color. 
• Label Font. Click the button to see font and color options. 
• Status Line Font. Click the button to see font and color options.  
• Bar Spacing  

The default value is 40; a higher value of 60 moves the bars closer 
together so that the chart covers a greater time period.  
When you change this value, the current chart is not changed; the 
change takes effect when you open subsequent charts. 

• Max. Bar Width  
The default value of 0 assigns an automatic bar width that works well 
with OHLC bars. For candlesticks a wider bar is necessary; we have 
found that an even value of 4, 6, or 8 can be very effective.  
When you change this value, the current chart and all subsequent 
charts are changed. 

• Show Grid – Turns Grid ON/OFF. 
• Show Status Line – Turns Status Line on or off. When it is on, the Status 

Line appears in the upper left corner of the chart, and provides a summary of 
recent price action, including change, OHLC, and volume.  

 

After changing these settings, you may save your new settings as your custom 
defaults by clicking the Save as custom defaults button. You may also click the 
button for Reset to eASCTrend defaults or Reset to custom defaults to make quick 
formatting changes. Once you set your custom defaults, all the charts you open 
display these attributes each time you start eASCTrend. 

Copy and Paste 

After you have created the first chart window, you may simply use the Copy  and 
Paste  icons on the toolbar to quickly generate new chart windows. The copied 
chart will have the same attributes as the original chart, including symbol and 
interval.  
 
If it is an intraday chart, and you wish the new chart to represent the same market, but 
with a different time interval, you may type a number and press Enter on the 
keyboard to change the chart interval. If you wish the new chart to represent a 
different market, type the new symbol, for example, IBM, and press Enter on the 
keyboard. You can change the interval or symbol for all the charts in the same 
workspace by clicking the “All” button, and then pressing Enter. 

Arrange Windows 
If you want to have more than one chart open in a workspace at the same time, you 
have three menu options to automatically arrange the charts in your window: 
Cascade, Horizontal Tile, and Vertical Tile. You can access these options by 
clicking on Window on the menubar.  
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• Click on Horizontal Tile and two or three charts will be arranged in a column. 
Six, or eight charts will be arranged in two columns.  

• Click on Vertical Tile and two or three charts will be arranged in a row. Six, or 
eight charts will be arranged in two rows.  

• If you have four or nine charts, click on either Horizontal Tile or Vertical Tile. 
Four charts will be set up in a two by two square; nine charts will be set up in a 
three by three square. 

Once  you  have arranged the charts in a workspace, be sure to save the workspace so 
that the charts will be in your preferred arrangement the next time you open it. 

Bar Spacing  
You have two ways to control the spacing between bars on a chart, which determines 
how many bars can appear on a chart, and therefore the period of time the chart 
represents. First, as explained earlier, after opening a new chart you can set the bar 
spacing from 1 to 180 in the Chart Format window that appears when you click on 
Format in the menubar and then select Chart.  

Second, with a chart open, you can change the bar space setting for that chart with the 

 and  icons located in the middle of the toolbar. Pressing the  icon moves the 
bars closer together and pressing the  icon moves the bars farther apart. If you 
hold down the Ctrl key while clicking on the  and  icons, you increase the rate 
at which the bars move closer or farther apart.  

Also, remember that in the Chart Format box, Max. Bar Width allows you to 
format the width of the bars. 
 
• The default value of 0 gives an automatic bar width that works well with OHLC 

bars 
• For candlesticks, an even value of 4, 6, or 8 is suggested 

 

Info Window 
The Info Window gives detailed information on the trading activity during the time 
period represented by each bar. When you click  , the Info Window icon located 
on the toolbar, the cursor changes from an arrow to a crosshair. Click the crosshair on 
any bar in the chart, and the Info Window pops up, showing the Symbol, Date, 
Time, Volume, High, Low, Open, and Close for that bar. Depending on the kind of 
data feed you have, the information for the last bar on the chart is updated with every 
new tick in real time. 

If you have used the  feature on the toolbar to Setup Analysis and add indicators 
to the chart (see section on Indicators below), the values for those Indicators will also 
appear in the Info Window and will be updated with every new tick in real time. For 
example, if you have the eASCTrendTS indicator applied to the chart with the “% 
Trailing Stop” Exit Rule checked, and you’ve clicked on the last bar of the chart, you 
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will see the values for TPLP, TEP, and Will change to BUY/SELL at xxx (price) 
in the Info Window, where: 

TPLP is the Trailing Profit Level Price (Entry Price plus Profit Level), which 
is the price value at which the real-time profit-trailing algorithm will be 
activated. 

TEP is Trailing Exit Price, which can be higher or lower than the TPLP. Once 
the real-time profit-trailing algorithm is activated, you will be able to see the 
TEP value in the Info Window.  

If you are in a long position, when you click the last bar, you will see Will 
change to SELL at xxx (price). This means that the system will reverse to a 
sell position when the price reaches the indicated price. Conversely, if you are 
in a short position, when you click the last bar, you will see Will change to 
BUY at xxx (price). 

When you first open the Info Window, it will close as soon as you move your 
crosshair off the bar. To keep the window open, click on the blue arrow in the top-
right corner of the Info Window. The arrow becomes a blue dot and the box remains 
where it initially opened. To change the location of the Info Window, click and hold 
in the yellow box at the top of the window labeled Click here to drag, and drag the 
box to the desired location. Now you can click any bar on the chart with the crosshair, 
and the detailed information for that bar will appear in the Info Window. If you click 
on the last real-time bar while the trading session is in progress, the Info Window 
will continue to track the current real-time bar, and once that bar has closed, it will 
show the values associated with the newly formed real-time bar. Click the X at the 
top-right corner to close the Info Window. 

Please Note: The values for high, low, open, and close are normally shown in 
decimals. The following bonds are traded in 32nds and their prices are shown in 
32nds: us, ty, fv, and tu in the regular session, and zb, zn, zf, and zu in the night 
session. 103^06 means 103 and 6/32 and is equal to 103.1875.  

Holiday List 

Some markets are traded almost twenty-four hours a day. For those markets you may 
see some price data show up even on "holidays." Because these days are very thinly 
traded their data may be distorted, and  therefore could cause a problem for any 
trading signals you may have activated.  

If you want to remove such data, you may set up your own "filter for holidays" by 
clicking on  , the Holiday icon, in the toolbar. The Filter for Holidays dialog box 
will pop up. Choose the date of the holiday that you do not want plotted on the chart, 
and then click the Add button to add it to your custom holiday list. 

When you want to remove a holiday from your custom holiday list, highlight the date, 
and then click the Delete button to delete it. 

 

© Copyright 2000-2006 by AbleSys Corporation. All rights reserved. 10 



D. Working with Workspaces 
 

After setting up charts in a workspace, you must save that workspace so that your charts 
will be available to you the next time you start eASCTrend 6.0. A workspace in 
eASCTrend is a page that displays one or more charts according to your specified 
settings. You may display intraday charts, daily, or even weekly charts on the same 
workspace. And you can mix any symbols, or even types of markets. You can insert one 
or more indicators in each chart. Settings for symbols, indicators, and charts can be set to 
the default values or to values you specify. The following workspace options can be 
accessed from the File menu in the menu bar. 

New Workspace 
To be taken to the first empty workspace, from the File menu click New Workspace. 
Other ways to get to an empty workspace are to type the shortcut keys Ctrl-W, or 
simply click on an unused workspace tab at the bottom of the screen. There are a total 
of eight workspaces. Initially, the label on the tab of a blank workspace says 
Workspace followed by a number from 1 to 8. 

Save Workspace As 

After creating a new workspace, you must save the workspace to keep all of your 
settings. You can give your workspaces any name, such as SP, My Stocks, or 
DailyCharts, by choosing File > Save Workspace As…. The default working 
directory is eASCTrend C:\Program Files\AbleSys\eASCTrend60\Workspace. All 
workspaces are stored in this working directory. File names of the workspaces use the 
.aws extension. Once a workspace has been saved, the tab at the bottom of the screen 
is relabeled with the name you assigned to the file. 

• Tip: The Save Workspace As. . . menu is also a quick way to create a new 
workspace. Simply open an existing workspace, change its settings for symbols, 
indicators, and charts, and then use the Save Workspace As. . . option to assign 
another name. This will save your new settings in a new workspace with the new 
name. 

Save Workspace 
After you change any settings in a workspace, you must save the workspace to keep 
all of the changes. To save a workspace, select the File > Save Workspace menu. 
You can also use the shortcut keys Ctrl-S or simply click  , the Save Workspace 
icon on the toolbar.  

Save All Workspaces 
You can use the Save All Workspaces menu item to quickly save all workspaces that 
are currently open. Click on File and then choose Save All Workspaces. Or, an even 
easier way is to simply use the shortcut keys Ctrl-A. 
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Open Workspace 
The Open Workspace menu allows you to open workspaces that are in your working 
directory. From the File menu, click on Open Workspace, or use the shortcut keys 
Ctrl-O, or simply click  , the Open Workspace icon on the toolbar. The Open a 
Workspace dialog box pops up and you can highlight the workspace you wish to 
open. You can also press the Ctrl key to highlight more than one workspace to open. 

Close Workspace 
The Close Workspace menu item under File allows you to close a selected 
workspace. You may also simply click on  , the Close Workspace icon on the 
toolbar.  

• Tip: If you don’t like changes you have made to a workspace, close that 
workspace without saving it. When you open it again, it will have returned to the state 
it was in the last time you saved it. 

Delete Workspace 

The Delete Workspace menu option allows you to delete a selected workspace. The 
shortcut keys Ctrl-D have the same function. 

• Note: Delete Workspace removes the workspace from your screen and deletes 
the file from your computer’s disk drive. If you delete a workspace, you can never 
open it again. 

Save All Unsaved Workspaces on Exit 
When you exit eASCTrend, the computer will ask if you want to save all unsaved 
workspaces. Click on Yes if you want to save any changes made during the current 
session. Click on No if you do not want to save any changes made since your 
workspaces were last saved. Click on Cancel if you want to continue your current 
session. The next time you start eASCTrend, you have the default option to open the 
workspaces listed in the tabs when you exited. If you did not save them when you 
exited, the workspaces will be opened using the settings from the last time they were 
saved. 

E. Working with Indicators 
 

We now come to the primary feature of eASCTrend. To analyze markets and help you 
make trading decisions, eASCTrend allows you to apply your choice of Indicators to 
your price charts. These include proprietary indicators, such as eASCTrendTS, 
eASCTrend2, and others, along with common indicators such as the moving average, 
RSI, Bollinger Bands, etc. Many of these indicators come with buy and sell alert signals 
that you have the option to turn on and off. To see the complete list of available 
indicators that you can apply to your charts, click on the  icon in your toolbar. You 
will find further discussion of these specific indicators throughout this Manual. You can 
apply as many or as few as you wish to any chart. One informational indicator we 
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mentioned earlier that some traders find useful is the Status Line, which provides you 
with an up-to-date summary of a market’s price action.  

Format an Indicator 
When you first apply an indicator to your chart, it is initially plotted with default 
settings. However, you can change the default settings by custom formatting the 
indicators to your preference. 
 
There are two ways to format indicators: 
 

1. You can format an indicator at the time when you insert it. After clicking the 
 icon, click the Format Indicator button in the resulting dialog box. This 

brings up the Format Indicators dialog box. Use this method to format 
indicators on the chart you are viewing, or check the Save as Custom 
Defaults button to apply your new formatting to other charts. 

 
2. You can also format indicators by clicking Format on the menubar, and then 

Indicators. The Format Indicators dialog box will display. Use this method 
for global settings of indicator formats on the currently selected chart and on 
any new charts for which indicators are desired. Please note that you need not 
have a chart open to access the Format Indicators dialog box in this way. 

 
You can format settings for Parameters, Style, Color, Weight, Subgraph and 
Enable Alert. 
 
Please see Appendix A. Adjust eASCTrend Indicators for further information on 
adjusting the parameters. 

 

View eASCTrend Values from Info Window 
 

As you will recall, when you move your mouse across a chart, the shape of the cursor 
indicates whether or not you have activated the Info Window option. A crosshair 
cursor indicates that you are able to view the Info Window, while an arrow cursor 
indicates that you are not. In order to switch between the two states, click Tools > 
Info Window, or, simply click the  icon on the toolbar. When you have the 
crosshair cursor, click on any bar on the chart and the Info Window will appear on 
the screen. 
 
Additional information will appear in the Info Window, depending on which 
indicators you have applied to the chart. For example, if you have applied the 
eASCTrendSig indicator, click on any bar and you will be able to see values for the 
eASCTrendSig BuyStop or SellStop in the Info Window (this value can be used as 
a protection stop for a reduced risk entry). Other eASCTrend stop values you can see 
in the Info Window are: BuyStop2 and SellStop2 when eASCTrend2 is applied; 
BuyStop3 and SellStop3 when eASCTrend3 is applied. Please note that the use of 
Buy and Sell in the names is position oriented (long or short), not order-type oriented. 
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If you place stop orders for a long position, you will place a Sell Stop order with the 
BuyStop2, the BuyStop3, or the eASCTrendSig BuyStop values. If you place stop 
orders for a short position, you will place a Buy Stop order with the SellStop2, the 
SellStop3, or the eASCTrendSig SellStop values. 
 
As you become more familiar with the different indicators and how they impact your 
trading decisions, you will gain a greater understanding of the key information that’s 
made available in the Info Window. 

 

Status Line 

The Status Line shows the Date, Time, Symbol, Net Change, Close, High, Low 
and Volume of the last bar on the chart. The eASCTrend default has the status line 
enabled and displayed at the left-top corner of the chart. You can choose to keep the 
Status Line displayed or turn it off.  
 
There are three ways to toggle the Status Line on and off: 
 

1. Use the Format > Chart menu to turn the Show Status Line on or off by 
checking or un-checking the box in the Chart Format dialog box. 

2. The on/off state of the Status Line on a selected chart can also be toggled from 
the Tools > Status Line menu by clicking on Status Line.  

3. You can also toggle the Status Line and format its Color, Font and Size by 
clicking the Status Font button in Chart Format dialog box. 

 

Refresh an Indicator 
In real time, indicators are updated with every incoming tick. If you subscribe to a 
data feed that supplies intraday price data, before any bar closes, the High, Low or 
Close prices keep changing; therefore, the values of indicators on the chart keep 
changing, too.  
 
As you may know from your own experience, as data keeps flowing in, occasionally 
the market will supply a bad tick. This is usually corrected as additional data comes 
in. However, you should be aware of this possibility, and when eASCTrend alerts you 
with a buy or sell signal, you should refresh the chart to avoid possibly acting on 
erroneous signals that are associated with bad data. A single chart or all charts may be 
refreshed by clicking on Tools on the menubar (or right clicking on a chart) and then 
clicking on Refresh Current Chart or Refresh All Charts.  
 
Refresh clears the chart and then loads all new data from the data service history. 

 

Save Indicators with the Chart 

After you set up your first chart window with eASCTrend indicators according to 
your preferences, you can use this chart window as a template for additional charts. 
Use the Copy  and Paste  icons to create new chart windows quickly. After 
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pasting, click the new chart and type in a new symbol (the first key press opens a 
dialog box). When you save the workspace, all the attributes, including the indicators 
you applied, will be saved. 

 

Alerts 
The following eASCTrend indicators are capable of sending alerts:  

eASCTrendTS (see Appendix C for alert description and when it is heard) 
eASCTrend1 
eASCTrend3 
eASCTrendSig 
Bollinger Bands 
ADX 
 

Note: eASCTrend2 does not have an alert of its own, but there is an alert for HTM 
(Hybrid Trading Method – see Part Two of this manual) which is triggered by 
agreement between eASCTrendTS and eASCTrend2.  

 

To turn on the alert for an indicator, place a check in the Enable Alert box in the 
Format Indicators dialog box. Or to toggle the alert between on and off, go to the 
Insert Analysis dialog box and double click on the words Alert On or Alert Off next 
to the name of each indicator you’ve applied.  

The HTM alert is unique. It’s On when eASCTrendTS and eASCTrend2 are both applied to 
the chart and the eASCTrend2 alert is set to On.  The HTM alert is Off if either the 
eASCTrend2 alert is set to Off or one of the two indicators is not applied to the chart. 
eASCTrend2 does not have an alert on its own. 

Click  , the music alert icon in the toolbar, to toggle the buy and sell signal sound alert on 
and off. 

E-mail alerts can be set up in eASCTrend to be sent through Outlook Express. 

1. From the Format menu, select Email Alert, place a check next to Enable alert by 
email, and then type in your e-mail address. 

2. Set up Outlook Express as your default: from the Outlook Express Tools, select 
General. In the lower part -- Default Messaging Programs, click the Make 
Default button for using Outlook Express as your default mailer. 

3. Set up the Outlook Express security: from Outlook's Tools, select Security. DO 
NOT check (uncheck) the "Warn me when other applications try to send mail as 
me." 

AutoScan 
Once you have your Indicators set up, you can use AutoScan, one of our most helpful 
features. With AutoScan activated, you no longer have to look through long lists of 
symbols each day to discover which ones present a trading opportunity. AutoScan 
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searches through your list of market candidates for you, and identifies the symbols 
that currently offer tradable buy and sell signals. Then it alerts you to these excellent 
trading candidates by marking them in a comprehensive AutoScan report, as well as 
a pop-up alert. AutoScan can search your list using end-of-day (EOD) data, or, if you 
subscribe to a real-time data feed, it will constantly monitor your symbols in real-time 
(the Real-Time box in your Portfolio Data List needs to be checked. See procedures 
below). AutoScan works with your Custom Data List (which you input yourself 
using the procedure described below), or it will use a symbol list you download from 
WinTick and import into your Custom Data List (refer to instructions in the 
Beginner’s Video 1). We recommend that you use eASCTrendTS to run with 
AutoScan.  
 
Procedures: 
1. To set up your Custom Data List and select indicators for AutoScan, select the 

Setup AutoScan option under Tools in the menubar, or simply click the  icon  
in the toolbar. The Portfolio Data List dialog window appears. 

2. You can enter a filename for your symbol list, such as My Stocks. Or, you may 
type in symbol names in the format of one per line, such as MSFT, GE, CSCO... 

3. Choose either the Daily or Weekly option for the chart. 
4. Specify Last Date and Duration for the chart 
5. Check the boxes of your choice of indicators, being sure to double click to turn 

the alerts ON. 
6. With eASCTrendTS, you may have the computer scan for the best value of 

Trading Signal Performance Control (TSPC – which is discussed fully in Section 
C of Part III of the Manual). Specify the number of shares and the cost per trade 
by clicking on Format in the menubar, and then Trade Signal. This opens the 
Set Global Trade Signal Formats window. 

7. Once you’ve entered your parameters, click OK to save the settings of your 
custom data list. 

8. Click  in the toolbar, and then the Run AutoScan button to start the scanning. 
Or from the menubar, select Tools to open the menu and select Run AutoScan. 
We suggest you run AutoScan while the market is closed. However, you may run 
AutoScan in the background in real time. When you run AutoScan, it will open a 
window with your custom data list. You can see the percentage meter of the Scan 
Process in the Status Bar. 

9. After the AutoScan is finished, you may click the View Scan Results button or 
from the menubar select Tools > View AutoScan Results. The results display the 
date, time, symbol, interval, signal name and triggered price. 

10. You may Go to Symbol Chart, Delete Line, Save As File, Print Results or 
Cancel by clicking the buttons on the View Scan Results window. 

 
F. Trading Strategies Reference Table 

 
Part Two of this manual covers the Hybrid Trading Method (HTM). Part Three covers the 
100% mechanical trading method.  Depending on your markets and trading style, you will 
be more interested in reading Part Two or Part Three. The following table gives you a quick 
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guide to which markets and trading styles go best with either HTM or the mechanical 
trading method so that you can go directly to the section of the manual that’s most relevant 
to your interests. If you prefer to trade with HTM , please read Part Two. If you prefer to 
trade with 100% mechanical signals, please read Part Three. 
 
 
 
 

 
 Day Trading 

Below 30-min 
Swing Trading 

30-min or Above 
Position Trading 

Daily/Weekly 
Stocks HTM only HTM/100% Mechanical HTM/100% Mechanical 
Mutual Funds Not applicable Not applicable HTM/100% Mechanical 
Index Futures HTM only for minis HTM/100% Mechanical HTM/100% Mechanical 
Commodities HTM only  HTM/100% Mechanical HTM/100% Mechanical 
Forex HTM only, avoid. HTM/100% Mechanical HTM/100% Mechanical 
Bond HTM only HTM/100% Mechanical HTM/100% Mechanical 

 

 

G. Establish your Trading Strategy: The right way to use eASCTrend software 
 

To be successful, traders must treat their trading activity as a business. This means 
developing a business plan, which includes adopting a set of trading strategies that can be 
implemented using specific, predetermined rules. 
 
Effective trading requires discipline. Disciplined traders only trade price actions and 
patterns that fit the strategies and rules they’ve adopted. They are selective in entering 
trades because they know that depending on the strategies and rules they’ve chosen to 
adhere to, not all price actions are tradable. The gamut of possible market price patterns 
is unlimited, and it isn’t possible to come up with strategies and rules that fit every 
possible market condition. This is why traders should stick with the kind of trades that fit 
their rules and that have worked for them in the past.  
 
If you are constantly adjusting your strategies and rules to fit new price patterns, you 
eventually become a rule-less trader without any discipline. That is why you must adhere 
to specific trading strategies and rules that are only appropriate for the kind of market 
price actions you are comfortable trading. If market price actions do not fit your trading 
strategies and rules, do not trade them. 
 
Patiently wait for the price pattern you’re looking for to present itself before entering a 
trade. If the opportunity you seek is not available right now, be assured that other 
opportunities will soon present themselves. The market constantly alternates between 
narrow range price consolidations and large range price movements; the ratio of price 
consolidations to price movements is approximately 80:20. Experience has shown that 
during price consolidations it is not appropriate to initiate trend-following trades. 
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Experienced and successful traders report, however, that they have very good success 
when they take the entry point at the END of a price consolidation. So be patient and very 
selective, and wait for the right time to enter trades. 
 
Here are additional points to consider in developing your trading business: 
 
• Only enter a position at the optimal entry point. AbleSys software helps you 

recognize this point by presenting colored indicators that you can follow by applying 
simple rules. These indicators, along with sound alerts, allow traders to easily follow 
their trading program. 

 
• Using dynamic trailing stops is the only way to manage your risk. The software will 

help you to manage your current open positions by offering very specific initial stops 
and trailing stops. 

 
• Spread your trading risk by diversifying your account or strategies whenever you can. 

For example, if you trade stocks, you can determine your per symbol buying power 
(how much to invest in any one stock) by dividing your usable buying power by the 
number of markets you wish to trade. You can determine the number of shares of that 
stock to buy by further dividing the per symbol buying power by the price of the 
symbol. If you trade e-minis, futures, commodities, or Forex, it is always a good idea 
to diversify your markets. 

 
• Always put aside 20-30% of your buying power as a reserve. Every trading system 

and strategy will face periods of drawdown; you need sufficient reserve in order to 
keep going through these periods. (See the discussion of Maximum DrawDown in 
Part Three, Section B of this Manual.) 

 
• Trading is a long-term venture. You need a plan as well as patience. Looking for 

immediate results with instant gratification will cloud your judgment.  
 
Learn to walk before you can run. Learn all the rules and strategies first. Practice or simulate 
trades before you trade with real money. 
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Part Two - eASCTrend 6.0 – The Hybrid Trading Method (HTM) 
 
A. Introduction to HTM 

What Is HTM? 

The Hybrid Trading Method combines the decision-making power of the AbleSys 
analytical software with the trader’s own experience and intelligence.  HTM is a trading 
method that combines two indicators – eASCTrend TS (the back-testable mechanical 
buy/sell Trading Signal), along with eASCTrend 2 (our classic indicator) – to make 
trading decisions in any market with interval charts (i.e., prices plotted over time). It can 
be used for day trading, swing trading and position trading. HTM employs a set of easy-
to-follow entry and exit rules that offer very low risk and that remove most of the 
guesswork from trading. Many traders use HTM on a daily basis.  
• HTM can be used for any interval charts.  
eASCTrendTS responds quickly to market conditions while eASCTrend2 responds more 
slowly. The combination of the two indicators works in any time interval to give the 
trader a more complex and comprehensive analysis of the market. 

• HTM can be used equally well for Day Trading, Swing Trading, and Position 
Trading in any market. 

The dual timing of the two indicators is ideal in that it reduces the whipsaw effect 
frequently experienced in the small intervals used in day trading. We see the same 
advantage when HTM is used for swing trading and position trading. 

• HTM can be used for trading any size account.  
The lower drawdown experienced with the Hybrid Trading Method makes it not only 
desirable for use with large accounts, but with medium and small accounts as well. 

• HTM is easy-to-learn and easy-to-use.  
The Hybrid Trading Method can be applied to a chart in seconds with a click of your 
mouse. Traders can quickly learn the few easy rules required to implement the method. 
HTM even comes with buy and sell alerts which are triggered by agreement between 
eASCTrendTS and eASCTrend2. 

• HTM is almost completely objective and mechanical.  
To know when to enter the market, traders need only watch the mechanical 
eASCTrendTS – which provides a winning framework – and then watch for agreement 
with the classic eASCTrend2 indicator – which gives a very accurate prediction of the 
direction the market is likely to take. All this information is clearly marked on the chart. 
Because signal agreement can follow chart formations that extend over different periods 
of time, traders can apply their own experience in deciding when they are comfortable 
with the risk offered by a particular trade. Once traders have entered a market position 
using the Hybrid Trading Method, they can follow the stop rules very mechanically. 

• HTM can dramatically remove guesswork during trading. 
Using HTM reduces the influence of emotions on traders’ decisions because it allows 
traders to approach a trade with a predetermined plan, and then strictly follow the 
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indicators on the chart.  

The Benefits of Using eASCTrend 6.0 HTM 

As a rule, we find that markets tend to exhibit regular price patterns with clear up trends, 
down trends, or consolidations, approximately 80% of the time, and irregular price 
patterns for perhaps the remaining 20% of the time.  Therefore, while the nature of the 
market can be quantified or predicted most of the time, there are significant times when it 
cannot be quantified or predicted.  However, it is during those difficult-to-predict yet 
critical times between irregular and regular periods that traders find their greatest profit 
opportunity. HTM addresses this market challenge by using a time-tested analytical 
software system, combined, to a limited extent, with the critical addition of the trader’s 
own intelligence, to maximize traders’ ability to take advantage of market conditions.  
HTM meets the needs of traders with technology that is both powerful and easy to use: 
• Back-testable eASCTrend TS sets a winning framework, giving traders increased 

confidence in following the system.  Confidence is crucial to trading success.   

• The highly accurate eASCTrend2 evaluates and displays the market direction so that 
traders are more likely to enter on the right side of the market, and therefore have the 
opportunity to experience a high winning rate. 

• Signal agreement between the quick to respond eASCTrend TS and the slower to 
respond eASCTrend2 helps traders avoid choppy markets while capturing the trend in 
an early stage.  This helps to increase traders’ winning rate and performance. 

• The easy-to-follow entry rules, referred to as C.A.R.E. (described in Section C of Part 
Two), identify the high reward, low risk optimal entry point for trend-following 
traders as well as traders who employ trend-following scalping or low-risk scalping.  
The objective rules used with HTM make trading less discretionary. 

• Specific HTM initial stops, trailing stops, and exit stops offer minute-to-minute trade 
management. HTM provides lower risk by enabling traders to use relatively tighter 
stops associated with smaller time intervals. Tighter stops help to minimize the 
human discretionary element in risk management and exit management. 

• HTM is also flexible in that it incorporates each trader’s own experience within the 
HTM framework. Since we are trend followers, the most critical issue for successful 
trading is to identify a trend in its early stages. In order to accomplish this while 
avoiding choppy markets, traders need specific knowledge and guidance. HTM’s 
Thrust, Triangle and Time Unit (T.T.T.) techniques (see below) assist traders by 
providing specific guidelines that help them to identify the trend and increase the 
likelihood of winning trades. 

• Virtual Paper Trading (VPT) is available in all versions of eASCTrend 6.0 to help 
traders improve their skills by allowing them to simulate trades without using real 
money. Traders can conduct VPT to practice trading strategies using either historic 
data or real-time streaming data. 
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• HTM is easy to apply to any chart, and easy to implement.  While viewing a chart, 
simply click on the HTM icon on the toolbar, and the HTM settings with eASCTrend 
TS and eASCTrend2 are applied to the chart with the correct parameters. The HTM 
alert window with sound will pop up to indicate when the market offers the best HTM 
entry point. 

Common Terms Used In Discussing HTM 

1. Support and resistance 
Support and resistance are areas on a price chart; support is like a floor that prices 
can’t seem to fall below, and resistance is like a ceiling that prices can’t seem to 
rise above. When prices finally do break through support or resistance, this is a 
critical event that may influence a trader’s decision to enter or exit a market. If a 
trader says, “When that stock goes below $50 per share, I’ll buy a thousand 
shares,” then $50 is the support price for that trader.  And if a trader says, “When 
that stock goes above $60 per 
share, I’ll sell all my shares,” 
then $60 is the resistance price 
for that trader.  Support and 
resistance are revealed through 
the prices on a chart, which 
represent the collective 
decision making of millions of 
people who are constantly evaluating thousands of financial instruments to choose 
the best buy and sell prices.  Support and resistance are constantly changing.  
After the fact, it’s easy to draw lines on a chart to represent support and 
resistance.  It’s not as easy to paint dynamic support and resistance areas on a 
chart in real time, but that is what we do with eASCTrend 2. 
 

2. Trend movement  
When consecutive high points on a chart are higher, and consecutive low 
points on a chart are also higher, then that portion of the chart is in an up 
trend, or a long trend. 
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When consecutive low points on a chart are lower and 
consecutive high points on a chart are also lower, then 
that portion of the chart is in a down trend, or a short 
trend.  

 
3. Pullback/retracement  

When a chart that’s in an up trend has a higher high, and then the price 
drops lower, but not as low as the previous low, it is called a pullback or 
retracement. Conversely, when a chart that’s in a down trend has a lower 
low, and then the price goes higher, but not as high as the previous high, it is 
again called a pullback or retracement.  It is critical to watch what happens 
after a pullback or retracement:  Does the trend continue? Does it reverse? 
Or does the market enter a period of consolidation? 
 

4. The second test 
The second test occurs after a retracement and indicates whether prices are 
going on to continue the trend. In an up trend, the second test is a re-test of 
the recent highs. In a downtrend, the second test is a re-test of the recent 
lows.  The up trend is continuing if the re-test breaks the recent highs. The 
downtrend is continuing if the re-test breaks the recent lows.  The aggressive 
eASCTrend2 stops are used during periods of trending. Use the conservative 
eASCTrend 13 (T13) stops during a re-test. (The T13 indicator, which is 
discussed further below, is part of TS and is represented by the dots when 
TS is applied to a chart.)  Return to using the eASCTrend2 stops if the trend 
holds after the second test.  
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5. Consolidation  
Sometimes, instead of trending up or down, prices on a chart stay within a 
relatively narrow range. When consecutive high points on a chart are the 
same or lower, and consecutive low points on a chart are the same or higher, 
then that portion of the chart is said to be in a period of consolidation.  
Towards the end of consolidation, the range of price movement tends to 
become even narrower. Breakouts at the end of periods of consolidation 
offer attractive market-entry opportunities. 
 

 
 
6. Thrust, Triangle, and Time  

A Thrust move is a strong trend, either long or short. It is often followed by 
a period of consolidation that roughly forms a triangle. Time is the ratio of 
the number of bars of consolidation divided by the number of bars of thrust. 
The larger this number is, the more aggressive a trader can be in responding 
to a breakout of the triangle. 
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B. How To Set Up a Chart with HTM 
 

1. Insert the symbol you wish to trade 
First, open the chart of the symbol you wish to 
trade by clicking on Insert on the menubar, 
selecting Symbol, and typing the symbol into 
the dialog box. HTM works with any type of 
market because the eASCTrend indicators work 
with any type of market.  Whether you trade 
stocks, futures, bonds, or the Forex, eASCTrend 
will work well for you.  Traders should choose 
markets according to their own style of trading 
and available capital.  A highly leveraged 
instrument may be right for some traders 
because it offers a very high potential for profit, but that same instrument may be 
wrong for others because it presents a higher risk than they can tolerate. 
 

2. Choose the time interval 
There is no universally optimal time interval to trade. 
Traders must select appropriate time intervals for their 
market according to their risk tolerance and profit 
expectation. AbleSys software is very flexible and can be 
used for any time interval. The advantage of using a 
smaller time interval is that the initial risk is lower due to 
the smaller price swings. In comparison, large time 
intervals offer relatively larger initial risks. However, 

smaller time intervals involve more overhead because they require a larger number 
trades. Also, signal accuracy is relatively lower compared to longer time intervals.  
 

3. Apply eASCTrendTS (TS) and eASCTrend2 (T2) 
Once a trader has a chart with green bars pulled up, it is extremely easy to apply the 
two indicators correctly.  Move the mouse to the icon on the 
far right of the icon tool bar labeled HTM and click on it.  
This is all that’s required. 

Immediately upon clicking on the HTM icon, the HTM 
analysis is applied to the chart: 

• The eASCTrendTS (TS) analysis is applied with 
the default settings which paint the price bars dark 
blue where prices are in an up trend, and red where prices are in a down 
trend. Where prices are consolidating, the bars remain green.  A large 
cyan/ light blue dot (for an up trend) or magenta dot (for a down trend) is 
placed on the first bar of a new trend. A small dark blue dot (in an up 
trend) or a small dark red dot (in a down trend) is placed below or above 
the bars respectively to represent the eASCTrend 13 stops. 

• The eASCTrend2 (T2) analysis is applied with our default settings. This 
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places medium-sized light blue dots (for an up trend) or magenta dots (for 
a down trend) below or above the bars to represent the T2 stops. 

 

 
 

The top chart shows only the TS indicator, and the bottom chart shows only the T2 
indicator. They are separated here so that you can clearly see each of the two 
indicators.   
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Generally traders apply both indicators to one chart as shown below: 

 

 
 
 
 
4. HTM Alerts 

You can enable an alert for HTM which is 
triggered when the eASCTrend TS and 
eASCTrend 2 indicators agree. Both 
eASCTrend TS and eASCTrend 2 must be 
applied to the chart and the eASCTrend 2 
alert must be set to On in the Insert 
Analysis dialog window under the  
icon in the toolbar.  The HTM alert is off 
if  the eASCTrend2 alert is set to off or either indicator is not applied to the chart.  

 

5. Adding a Guidance Chart 
Using guidance windows is optional, but it can increase trading confidence.  
Traders who use guidance windows normally like to use guidance charts with 
relatively longer time intervals than the charts they are trading.  For example they 
might use daily charts as guidance charts along with 30-min trading charts for 
swing trading, or they might use 30-min guidance charts along with 3-min trading 
charts for day trading.  We call the charts with the shorter time interval the 
“trading windows,” and the charts with longer time intervals the “guidance 
windows.” Traders will follow the signals and stop values in the trading windows 
to execute trades.  The ideal scenario is to find tradable opportunities in the 
trading window that are also in agreement with the directional bias indicated by 
the guidance window. For example, it is ideal to trade a long (buy) TS/T2 
agreement in the trading window while the guidance window also indicates a long 
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(buy) TS/T2 agreement.  

Sometimes, it is not appropriate to mechanically enforce a directional agreement 
between the trading window and the guidance window with equal weight (50/50). 
Under certain conditions we should give more weight to the signals in the trading 
window to “break the tie.”  For example, when you see a significant price 
movement, you can expect it to be followed by a very long period of price 
consolidation, perhaps 3 to 4 times the length of the major price movement.  If the 
major price movement takes one hour, traders need to be very conservative in 
taking trades in the next three to four hours during which consolidation may be 
taking place. However, after three or four hours of consolidation in the trading 
window, the signals in the guidance window are less important.  Traders should 
be very aggressive in taking trades from this point if they see signal agreements in 
the trading windows, regardless of the direction in the guidance windows. 

 

 

 
 guidance window trading window 
 
 
 

C. Hybrid Trading Method Entry Rules 
 

1. C.A.R.E. 
The Hybrid Trading Method entry rules are described with the acronym CARE: 
Consolidation – wait for a narrow range breakout at the end of a consolidation 

Agreement of TS and T2 – get ready to enter a trade after the indicators agree 

Retracement - lower risk by entering during the retracement (optional – see details 
below). 

Enter - with the reappearance of a small red or blue bar coupled with agreed T2 dots 
 

2. Consolidation: Identify and then watch for its end 
Periods of consolidation in a market usually follow large thrust moves, either 
long or short, and they are followed by another thrust move. The most 
important task of a trend-following trader is to identify the end of a period of 
consolidation. This is the best time to initiate a trade because the market has 
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the potential to soon make another major move, while the likelihood that the 
consolidation will continue is diminished. To help us recognize the end of 
consolidation we look at three key elements on the chart, which we call the 
three “Ts”: a) the Thrust leading up to the consolidation, b) the Triangle shape 
of the consolidation, and c) the relative Time. 

a. Thrust precedes, and helps traders identify, consolidation 
A thrust is a significant movement in market price. It’s easy to identify a 
thrust move by examining the previous 50 to 100 bars on the chart.  For 
day trading, a major move is about 70-80% of the recent daily price range. 
For swing or position trading, you can easily identify the biggest recent 
price movement as a series of blue bars (indicating an up trend) or a series 
of red bars (indicating a down trend). After this significant market price 
movement occurs, it is important to be conservative about entering trades, 
because it is very likely that there will now be a period of consolidation. 
 

b. The triangle narrows as it approaches the end of consolidation 
A thrust move is commonly followed by a long period of consolidation.  
As consolidation proceeds, prices trade in a more and more narrow range, 
creating a triangle configuration on the chart. The narrow end of the 
triangle points toward the end of consolidation.  Ultimately the triangle 
may narrow down to several consecutive bars that have roughly the same 
lows and highs. Watch for the breakout at this point and be prepared to 
trade more aggressively. 
 

c. Relative time (the ratio of the length of time of consolidation to the length 
of time of the thrust) is critical 
Calculate the “relative time” as the ratio of the number of bars of 
consolidation divided by the number of bars of thrust.  For example, if the 
thrust lasted about 14 bars, and the period of consolidation has lasted 
around 40 bars, then the relative time is close to 3.  As this relative time 
becomes larger, the more aggressive a trader can be in responding to a 
breakout. 
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Signs that the market is still in consolidation include large-size bars that move 
in opposite directions, and bar colors that keep changing.  Traders should be 
very conservative in this kind of market, knowing that the direction of the new 
trend has yet to establish itself. 

Deciding whether a period of consolidation is long enough to warrant trading 
it on the breakout is the only part of HTM that requires traders to leverage 
their experience. Once traders decide that this is a good formation to trade, the 
entry points and stop management are controlled almost 100% by the software 
program. 

3. Agreement of TS and T2 
The relatively quick to respond eASCTrend TS paints a large cyan/light blue  
dot on the first bar of a long trend.  It paints that bar dark blue and all 
subsequent bars are painted dark blue (long) or green (long hold) until it 
reverses its position, which it indicates with a large magenta dot on the first 
bar of a short trend.  Then it paints that bar red and all subsequent bars are 
painted red (short) or green (short hold) until it reverses its position again.  
The color of the bar is part of TS, and indicates the direction of the current 
market price (dark blue is up, red is down, and green is neutral). 

The relatively slower to respond eASCTrend 2 indicates the direction forecast 
as well as the key support and resistance areas.  Where prices are trending up, 
it places medium-sized cyan/light blue dots below the bars at the point of 
support. Where prices are trending down, it places medium-sized magenta 

© Copyright 2000-2006 by AbleSys Corporation. All rights reserved. 29 



dots above the bars at the point of resistance.  There are periods where T2 
does not appear on the chart, indicating that the price action is neutral. 
 
The agreement of the two indicators, eASCTrend TS and eASCTrend 2, is the 
single most important part of HTM in helping traders determine how they will 
respond to the market – and it is fully mechanical! 

There is an agreement for taking a long position if the bar is 
painted dark blue (eASCTrend TS) and there is a medium sized 
cyan/light blue dot below the bar (eASCTrend 2). 

 

There is an agreement for a short position if the bar is painted 
red (eASCTrend TS) and there is a medium sized magenta dot 
above the bar (eASCTrend 2). 

 
 

It may be easier to recognize when the two indicators are in agreement if we 
also examine when they are not in agreement. 

There is no agreement if the bar is painted green. 

           

There is no agreement if there is a bar without an eASCTrend 2 
medium-sized dot. 

           

There is no agreement if the bar is painted red and the medium-
sized cyan/light blue dot is below the bar. 

 

There is no agreement if the bar is painted dark blue and the 
medium-sized magenta dot is above the bar. 
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4. Retracement Sets Up a Low Risk Opportunity 

When prices have retraced, traders have the opportunity to enter a trade at a 
better price. However, not all retracements should be traded. Traders should 
look at the relative time of the current formation (approximately the number 
of bars of consolidation divided by the number of bars of thrust) in 
conjunction with other chart features to determine if the chart does indeed 
offer a good opportunity. Here are some guidelines traders can follow: 
 
Relative 

time 
Guideline 

1 Trading is not recommended unless traders can identify the trend with 
the traditional trend definition of higher highs and higher lows for an 
up trend, and lower lows and lower highs for a down trend. In this 
case, always wait for retracement to find a low risk entry point. 

2 Trade with caution. Traders need to see the end of consolidation and 
the breakout as well as retracement. 

3 Trade aggressively. Traders need to see a breakout. Retracement is 
optional. 

4 Trade very aggressively. Traders can act on every TS/T2 agreement 
without waiting for retracement. 

(Note: markets traded 24 hours [e.g., Forex and e-minis] exhibit lengthy 
consolidation periods during non-active trading hours that are not necessarily 
tradable. The above guidelines are appropriate for normal trading hours only.)  

Traders who skip the step of waiting for a retracement give up finding a low 
risk entry point and therefore risk being in a long position that they entered at 
a high point, or a short position that they entered at a low point. 

On the other hand, traders who wait for retracement risk missing out on 
entering a trade in a fast moving market.  However, while missing a trade may 
be frustrating, it will not negatively affect a trader’s bank account. 

Waiting for a retracement offers two advantages:  
• When the indicators resume their prior trend following a retracement, it is 

a good indication that the trend has strength. 
• When the market price retraces back, coming close to the position of T2, it 

offers a low-risk entry point since T2 will be the initial stop loss. 
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Traders need to predetermine detailed strategies they will use under different 
market conditions, and follow their rules with discipline during trading. 

5. Enter With the Reappearance of a Small Red or Blue Bar 
After retracement (or after breakout if retracement is skipped), there is a final 
mechanical test to determine whether to enter a trade:  Does the bar color 
(eASCTrend TS) still agree with the eASCTrend 2 medium-sized dots?  If the 
color of the bar has turned green (neutral) during retracement, traders should 
wait until the color of the bar returns to the color that agrees with TS and T2. 

The ideal situation is for traders to see a small-sized colored bar near an 
agreed eASCTrend 2 dot.  This is called a low-risk entry point. 

If traders have the HTM alert turned on, they will see an HTM popup window 
and hear a sound alert when the appropriate conditions are met.  Please note 
that the alert will mention HTM.  The program generates alerts whenever 
there is a TS/T2 agreement. Traders need to qualify each HTM alert with the 
C.A.R.E. rules before entering a trade. Not every HTM alert is tradable. Also, 
please note that the Agreement, Retracement and Enter conditions don’t have 
to appear on different bars. All conditions could be satisfied on one bar, as 
illustrated by the buy example in the chart below.  
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D. HTM Stop/Exit Rules 

1. Initial Stop (eASCTrend 2). 
Using the location of eASCTrend 2 as 
the initial stop makes decision making 
mechanical.  Use the Info Window to 
see the price value of T2.  Since T2 is 
an integral part of the decision to enter 
a position, traders know at the time they 
enter the market what their risk will be. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Trailing Stop (eASCTrend 2) 
Using eASCTrend 2 as the trailing stop also makes further 
decision making mechanical.  When the market moves 
sufficiently in favor of a position, T2 moves along with the 
market. Traders can move their stop along with T2, at first to 
reduce their risk, and then, as the trend continues, to protect 
their accumulating profit.  If the market turns against the 
position, T2 does not move. This keeps traders in the market 
during normal retracements so that they can take advantage of 
the longer trend, but will protect them from further losses if 
the retracement is major by stopping out the position if the 
stop is hit.  

 
 
 

3. Exit Stop (eASCTrend 13 or eASCTrend 2) 
If the market turns flat or makes a significant retracement, 
traders may want to be more conservative. They might 
therefore change their stop to the eASCTrend 13 stop value 
(which is part of TS).  This is a tighter stop and it is expected 
that it will be hit as an exit point.  If there is a second test and it 
fails, the tighter stop will better protect profit.  If the market 
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price breaks through with the second test, then traders can return to using the 
eASCTrend 2 trailing stop value. 
 

 
 
 

E. Some Tips 
 

1. Be cautious trading if you cannot see a trend. 
Become adept at recognizing a trend (higher highs and higher lows for an up 
trend/lower lows and lower highs for a down trend).  Be cautious trading if you 
cannot clearly see a trend on your trading chart. 

2. Don't trade if you feel compelled to trade. 
Don't trade if exciting market conditions make you feel compelled to trade, contrary 
to your predetermined trading plan.  Following your trading plan protects your from 
your own emotions. 

3. Enter a cooling off period. 
Stop trading (cool off) if you have made a series of unsuccessful trades in a very short 
time frame.  

4. Volume can be used to qualify some potential trend developments. 
The volume of a market can be used to help you interpret trend developments.  For 
example, when you see volume increase with the up-tick bars in a potential up trend, 
while you see volume decrease with the down-tick bars during that time period, then 
there is a high likelihood that the up trend is genuine. Volume needs to be viewed in 
relation to a group of bars. Relatively large volume associated with a single bar may 
be misleading since its true significance is uncertain. It is ideal to see breakouts that 
are supported by increased volume and follow-through price action. 

Be cautious trading if you don't see a clear association between volume and the 
development of the trend.  
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In this example, volume is higher when the market moves down and lower when the 

market retraces.  This suggests a strong short market condition. 
 

5. Enter special Exit Stops at major support/resistance (S/R) levels. 
eASCTrend tracks key support and resistance levels. Use major support/resistance 

levels (using S/R distribution tables, accessed by clicking on the  icon in the 
toolbar, from longer interval charts) to determine special potential entry or exit target 
areas. 
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F. Virtual Paper Trading  
Virtual paper trading is an ideal way to test trading strategies without risking any money. 
eASCTrend allows two types of virtual paper trading, giving traders great power and 
flexibility in trying out different methods and markets: virtual paper trading using historic 
data, and virtual paper using real-time data.  
 
1. Virtual paper trading (VPT) using historic data 

Traders can validate their trading strategy by setting up and following hypothetical 
trades using historic data. This goes far beyond what they can learn by simply 
examining the back-testing reports provided by the system. Traders can choose which 
indicators they want to include in their strategy and they can set the rules they want to 
use to interpret the indicators. They can use indicators alone using the Classic 
configuration of eASCTrend (for ASCTrend 3.5 TradeStation version indicator users 
or eASCTrend 6.0 users), or they can use those indicators in conjunction with the 
mechanical trading system if they have access to the eASCTrend 6.0 software.  In 
order to practice using the HTM rules, “hide” all the historic data to the right side of 
your chart by dragging the scroll control under your chart to the left. Then click the 
right arrow under your chart to “play back” the historic data one bar at a time. When 
you spot a good entry or exit point, launch the VPT to log your trades. 

To initiate VPT using historic data, right-click on any bar of your chart to bring up 
the right-click menu, and then click on VPT at This Bar (or use the Ctrl-Z shortcut).   
The VPT dialog box appears with the closing price of that bar already loaded. You 
can adjust that price according to your trading style and your interpretation of your 
trading rules.  Click the Manual Override box and enter the contract size or number 
of shares in the field called Size. In VPT, the order will use the price in the price 
field, whether it is the actual closing price, or a price you specified. Click on Buy to 
enter a virtual long position or exit a short position, or click on Sell to close a virtual 
long position or enter a short position. As soon as you click on Buy or Sell, a new box 
pops up to inform you that “Now you can manually place the order.” Click Okay, and 
your virtual order will be entered into your online Trading Log (see Section 3 
below). 

Please note that VPT cannot automatically simulate the stop orders for exiting trades. 
When you see a stop hit on the chart for your simulated trade, you need to manually 
enter the stop value (that appears in the Info Window) into the VPT price field before 
you place the virtual order to exit the trade.  
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2. Virtual paper trading (VPT) using real-time data  

 
Traders who have a real-time data feed can experience real-time virtual paper trading 
that closely simulates real-time trading by following trades as they actually unfold. 
This can be very effective whether using indicators, the mechanical trading system, or 
a combination of both. To initiate VPT using real-time data, right-click on the last bar 
of a chart and click on VPT at This Bar (or use the Ctrl-Z shortcut) to enter the real-
time bid price if Sell is chosen, or the real-time ask price if Buy is chosen. Using real-
time bid/ask prices closely simulates real-time order fill prices. Using virtual paper 
trading, traders can experience the dynamics involved in real-time trading, without 
being limited to entering trades at the bar-close price. As with VPT with historic data, 
as soon as you click on Buy, Sell, or Short, a new box pops up to inform you that 
“Now you can manually place the order.” Click Okay, and your real-time data VPT 
trades are entered into your online Trading Log. Again, prices are given in points for 
futures and must be multiplied by the point value. 
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3. Your VPT Trading Log  

 
eASCTrend maintains a record of your virtual paper trades in your Trading Log. To 
view your Trading Log window, click on File and then Show Trade Log, or use the 
shortcut Ctrl-T. A summary window for the trade can be displayed for any line in the 
log by clicking on that line. A completed trade log might look like this:  
 

 
The Trading Log allows traders to keep track of all their trades, both real-money 
trades and virtual trades. Traders can use the Trading Log window as a Virtual Paper 
Trading system by entering their trades as previously described. Traders can 
recognize their virtual trades because column #4, the Account column, reads 
“Manual Test.” 
   

G. Optional Indicators for the Hybrid Trading Method  
Here are additional indicators traders can place on charts, using the  toolbar icon: 
 
1. eASCTrend 1 (T1) and eASCTrend3 (T3) as a Substitute for TS 

The eASCTrend 6.0 TS indicator is actually made up of other indicators that were 
developed earlier. These include eASCTrend 1 (T1) and eASCTrend 3 (T3). 
Subscribers to the ASCTrend 3.5 indicator package (for the Trade Station charting 
platform), who do not have access to TS, can use T1 and T3 together as a substitute. 

T1 is similar to TS. T1 shows the direction of the current price via colors. When the 
market changes to or stays in an up trend, the bars become or remain BLUE. When 
the market changes to or stays in a down trend, the bars become or remain RED. 
When the market goes sideways or is not strong on either side, the bars become or 
remain GREEN. 

T3 is almost equivalent to eASCTrend 13 (T13), another component of TS which we 
mentioned earlier.  It offers a prediction of the direction of price movement and draws 
a price channel with Blue and Red dots.  BLUE DOTS below the lows of the bars 
indicate two variables: (1) the market is in an up trend; (2) the values of the BLUE 
DOTS are the protection stops or the profit target stops (if the position has 
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accumulated profit) for the long position.  The RED DOTS above the highs of the 
bars indicate two variables: (1) the market is in a down trend; (2) the values of the 
RED DOTS are the protection stops or the profit target stops (if the position has 
accumulated profit) for the short position. 

As we said earlier, eASCTrend TS can be replaced with eASCTrend 1 and 
eASCTrend 3, but do not apply eASCTrend TS and eASCTrend 1 on the same chart 
since one will paint over the other and lead to confusion. 

 
The top chart has TS and the bottom chart has T1 and T3 
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2. eASCTrendSig (TSig) as a Bonus Indicator  
Not all traders will be interested in using TSig, and it is not necessary to use, but it 
can serve as a bonus indicator for traders who find it of value. TSig studies current 
price action and offers the best entry points near areas of key support and resistance 
in conjunction with the prediction of price direction. Traders can use TSig to increase 
or decrease the number of shares or contracts in existing positions for proper trade-
level money management.  Normally we use TSig with default parameters (see 
Appendix A). Adjust eASCTrend indicators if you want to adjust the parameters.  

 
eASCTrendSig Buy/Sell signals 
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3. Adding Volume to the Chart 
Volume can help in the interpretation of price action and the identification of 
potential trend developments. The Volume indicator reports the trading volume for 
the associated bar.   

 

 
In this example, volume is higher when the market moves up and lower when the market 
retraces.  This suggests a strong long trend is in effect. 
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Part Three - eASCTrend 6.0 – The Mechanical Trading System 
(For Chart Intervals of 30 Minutes and Above) 

 
You can skip Part Three unless you strictly use the 100% mechanical trading system with 
portfolios such as: 

1. Automatic Order Execution (AOE) account 
2. Managed fund accounts for money managers 
3. Fully mechanically traded accounts for the purpose of diversification 
4. Fully mechanically traded accounts according to your trading style or trading plan 

 
Please note: Using a 100% mechanical trading system is only appropriate for chart intervals 
of 30 minutes or above. 

 
(Please read Part Two directly if you use HTM for Day Trading) 

 
A. What makes eASCTrend 6.0 a desirable mechanical trading system? 

Precise Buy/Sell Signals 

eASCTrend 6.0 provides 100% computer-generated buy/sell/exit signals with sound 
alerts. Based on these signals, Autopilot Order Execution (AOE) is possible. 

 

Robustness 

• Back-testing 
Our rigorous program of back-testing validates the trading system and allows us 
to derive the best system settings. Detailed back-testing results are posted at 
www.ablesys.com. 
 

• Forward testing (walk forward/simulation) 
Our ongoing program of forward testing is a true simulation of real-world 
scenarios where traders can use recent market data to determine the settings they 
will employ for their upcoming trading. The key system settings are derived from 
the sample data first (based on back-testing results) and then the settings are 
applied to the out-of-sample forward data. Forward testing results are available 
at www.ablesys.com.  
 

• System in action 
Examples of Dow Jones, S&P 500, and NASDAQ charts are updated on a daily 
basis. You may see them on our home page at www.ablesys.com.  

 

Time-proven/Universal 

• Time-proven award-winning software 
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eASCTrend has successfully survived both bull and bear markets for more than 
ten years. The program works and continues to prove itself effective in today’s 
markets. 
 

• Proven in a variety of markets 
eASCTrend has proven its effectiveness with stocks, mutual funds, bonds, futures, 
and Forex, as well as international markets. 
 

• Proven by a variety of users  
eASCTrend is used today by trading firms, banks, fund managers, trading 
advisors, and professional and individual traders worldwide. 
 
Since 1997, eASCTrend has been honored each year with Readers’ Choice 
Awards by Stocks & Commodities magazine in Futures Trading Systems, Stock 
Trading Systems, and Options Trading Systems. eASCTrend has convinced many 
of the most market-hardened traders, money managers, and CTAs that it can 
improve their trading results. Please see Appendix D for testimonials from actual 
customers. 

 

Easy to Use 

• No complicated charts to interpret. 
• Colored bars/dots indicate market directions at a glance.  
• Precise buy/sell/exit signals with sound alerts. 
• No need to use other indicators. 
• No need to constantly change settings once they are tuned to your preferences. 

 
Supports Money Management Strategies  

A winning system is the foundation for efficient money management 
Money Management (MM) is critical to effective trading. A good MM strategy can 
make a winning system even more profitable. However, MM is not a trading 
system—it cannot turn a losing system into a winner. Therefore, you must first have 
in place a winning trading system, such as eASCTrend, to support your MM strategy. 
eASCTrend 6.0 offers MM as an optional extra only in its End of Day Deluxe and 
Real Time Deluxe Plus software packages. 

 

Lets You Test for Yourself With Virtual Paper Trading Before Trading Real Money 

• Test the specific market you are trading. 
• Validate the settings by performing your own back-testing over a significant 

number of days, or even multiple years. 
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Enables Broker-assisted Trading  

• Broker-trade the system signal; then verify it at home.  
• Verify the accuracy of your broker’s execution. You and your broker receive 

synchronized signals generated by eASCTrend 6.0, making verification easy. 
• No more broker discretionary trading.  

 
B. Is the Mechanical System Trading Method the right solution for you?  

 

Some mechanical trading systems are profitable in the long run, year after year. However, 
some traders quit during those times when the system experiences periodic drawdown, 
especially major drawdown — although they may later regret their decision. A primary 
reason why people do not stick with a mechanical system is their failure to understand the 
nature of Maximum Drawdown (MDD).   

 

Understanding Drawdown 

The concepts of drawdown and maximum drawdown 
Drawdown, or loss as markets move against you, is an inevitable part of system 
trading. The goal of system trading is not to be perfect 100% of the time, but to have 
an overall preponderance of winning trades. At times a system might sustain a few 
consecutive losing trades, which will cause drawdown in the account equity. 
Maximum Draw Down (MDD) – the maximum loss from the high to the low in a 
market move – occurs in choppy markets, and may be daunting to traders who must 
maintain adequate margin reserve to hold their position during MDD. The following 
formula is suggested in funding an account:  
 
Initial Account Balance = Minimum Margin + 1.5 x MDD.  
 
In this formula use the 5-year MDD for your symbol. To get this information check 
the back-testing report by consulting the Mini Report in the Format Trade Signal 
for Active Chart window, accessed through the  icon in the toolbar, or by 
consulting the Trade Signal Report by clicking the  icon in the toolbar. Adjust 
the chart dates to cover 3 to 5 years if you are using a daily chart. The longer the time 
period, the more meaningful the back-testing will be. 
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Drawdown and Maximum Drawdown (MDD)  
 

Drawdown is a cost of doing business 
When you start a business, it’s necessary to plan in advance all the costs of 
running that business. It wouldn’t make sense to say, “I wish I didn’t have to buy 
inventory, to lease office space, or to hire people to do the job.” These are 
unavoidable costs. Likewise, when trading, it doesn’t make sense to say, “I hope I 
don’t have any losing trades!”  

 
Accept drawdown as inevitable 

Expecting to pick only winning trades is wishful thinking; such an outcome is 
impossible. You will lose your confidence as a trader if you hold yourself to an 
impossible standard.  
 
Instead, make it clear in your mind that while you follow system trading it’s not 
your job to know whether a trade will be a winner or a loser. Your job is to 
recognize the signals and execute them. Losses are an expense of system trading 
that should be planned for and accepted. It is only a matter of time (generally a 
very short period of time) before there will be new highs in the equity curve. All 
trading systems, even highly successful ones, spend most of the time in some sort 
of drawdown in between the occasional highs. 

 
Take a long-term view of system trading 

By taking a long-term view, a system trader can remain optimistic even while the 
system experiences a period of drawdown. When drawdown is understood to be a 
transitory condition, traders can maintain their faith in proven strategies. Trading 
is about winning over time and gradually building a growing equity curve. The 
outcomes of day-to-day trades are only part of a much larger picture. If you 
become frustrated unless your system constantly shows a profit, then you might 
want to reconsider whether system trading is appropriate for you.  
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Risk only the capital that you can afford to lose 
Risk capital is the money that you can lose comfortably and still maintain your 
lifestyle. Don’t start trading with capital that you need to live on. The market is 
notorious for taking “scared money.” 

 

Making a Commitment 
Trading as a business requires a serious commitment. Making a commitment is the 
first step to achieving any great success.  

 
Commit with an understanding of the nature of drawdown 

Once you verify for yourself that a system works over time, you can be 
comfortable with drawdown. By knowing that system trading is a winning 
strategy over the long haul, you can be willing and able to tolerate losses. When 
you understand fully that losses are part of the process of system trading, you 
replace fear with confidence. 
 
 

Sufficient capital 
A system trader needs to have sufficient capital. To sustain the maximum 
drawdown, the initial account balance is recommended to be: minimum margin + 
1.5 x MDD (using the 5-year MDD to be conservative).  

 
Persistence after consecutive losing trades 

Experienced system traders persist in taking trades, even after consecutive losses. 
Some traders even purposely initiate trading after sustaining consecutive losses, 
because they know that a drawdown is usually followed by large profit. 
 

C. Trade Signal (TS) and Adjusting the Factors That Affect It 
You can customize your mechanical trading system by adjusting certain parameters that 
affect the way Trade Signal (TS) – the heart of the mechanical trading system - functions. 

Trade Signal (TS)  
Trade Signal (introduced earlier as eASCTrend TS) is an automatic and mechanical 
trading system. Earlier we applied TS by using the  icon on the toolbar while 
looking at a chart, but you can also insert the TS into a chart by clicking  , the 
Apply Trade Signal Using Global Format icon on the toolbar. This causes the 
Format Trade Signal for Active Chart dialog window to pop up, which gives you 
many more options to customize your use of TS. If you don’t wish to make any 
changes, click OK to exit this dialog box. Buy and Sell signals will now be displayed 
on the chart. You can then view the system performance report using these settings by 
clicking  , the Display Trade Signal Report icon located in the toolbar. This 
report gives you a summary of how TS (applied with your parameters) back-tests in 
this market, in addition to providing a trade by trade track record.  
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Trading Signal Performance Control (TSPC) 

Trading Signal Performance Control (TSPC) allows you to customize how sensitive 
TS will be in signaling trades. TSPC is typically an integer from 0 to 10. The smaller 
the TSPC number, the more sensitive the system is, and the more trades are triggered. 
TSPC is a key parameter for a dynamic and self-adaptive trading system. To adjust 
TSPC, return to the Format Trade Signal for Active Chart window by clicking the 

 icon, and change the default number next to TSPC in the Parameters area. To 
help you choose this number, click on the  icon under Scan TSPC , which 
automatically finds an appropriate TSPC to generate your choice of either the best net 
profits or the best AbleSys Index. Normally you would select the best profit, but you 
might choose to select the best AbleSys Index if you want fewer and more efficient 
trades. Note that TSPC is similar to RISK in the classic version of eASCTrend.  

After clicking on Scan TSPC , the TSPC parameter will be adjusted to match the 
results of the scan. 

Deviation 

Deviation (DEV) is another key parameter that may be adjusted in the Format Trade 
Signal for Active Chart window to improve system performance. The main function 
of Deviation is to adjust eASCTrend stop values by a certain percentage to make 
them compatible with a trader’s level of risk tolerance. eASCTrend initially calculates 
stop values based on market conditions according to your risk preference. In practice, 
however, these theoretical calculations often deviate from real-time market 
conditions. Adjusting the value of the deviation enables the system to account for the 
difference between theoretical calculations and real data in assigning stop values.  

For example, if the buy stop (small blue dot) value is 100, setting Deviation at 1.0 
(%) will adjust the buy stop value to 99. Inversely, if the sell stop (small red dot) 
value is 100, setting Deviation at 1.0 (%) will adjust the sell stop value to 101. Since 
changing the DEV will vary the stop values, the entry points will also be changed 
accordingly. In general, when the market price crosses a sell stop, it is time to exit a 
short position and a buy signal is issued. And when the market price crosses a buy 
stop, it is time to exit a long position and a sell signal is issued. (Please note: Sell 
stops and buy stops are trading position-oriented terms. A “sell stop” is a protective 
stop value for a “sell” position. Traders need to use the “sell stop” value inside the 
Info Window to place a “buy stop order” in the order execution platform to protect 
their short/sell position.)  

There is an interaction between Deviation and TSPC: when TSPC has a larger value, 
the market price may need to make a greater movement in crossing a stop before a 
trade is signaled. The Info Window for the last bar on a chart displays the price that 
triggers a reversal of the position. 

Check Best Deviation to include this parameter along with Scan TSPC to determine 
the TSPC for best profit or best AbleSys Index. Alternatively, you can use the Scan 
Deviation feature to select this parameter for best real-time signal accuracy. Note that 
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Scan Deviation is available only when you are not using entry at bar close (EBC); 
however, entry at bar close is necessary if you have chosen to follow the system for 
mechanical trading. So, to use Scan Deviation you must temporarily turn off EBC.  

Real Time Signal Accuracy 

Prices fluctuate constantly during trading hours. Depending on the time interval of 
your charts, during real-time trading you will notice buy or sell signals that appear 
and then disappear before the bar closes. How many of these signals that are triggered 
in real-time, but then disappear by the bar close, are misleading, and how many can 
get you into successful trades?   

You can get your answer by learning the Real Time Signal Accuracy (RTSA) of your 
chart. RTSA is determined by calculating the ratio of bars that offer trade signals at 
the bar close, to the total number of bars that have signals that are triggered in real 
time. For example, if real-time signals show up ten times during the back-testing 
period, and two of those signals disappear by the bar close, the RTSA is 80%. It is 
important to know the RTSA before you decide upon the execution method you will 
use with eASCTrendTS signals. (See the discussion of eASCTrendTS Execution 
Methods below.) 

This phenomenon is not specific to AbleSys software. Every software system in the 
market presents trading signals or indicators in the same way. However, AbleSys 
makes it convenient for you to use this valuable signal by calculating the RTSA for 
you. Simply click on  , the Mini Report button inside the Format Trade Signal 
for Active Chart dialog box, and scroll the control on the right side of the Mini 
Report window to see the RSTA value at the bottom of the Mini Report.  

RTSA is not to be confused with system winning rate. System winning rate is the 
ratio of winning trades to total trades. For example, if ten trades are executed, and six 
of them are winning, the winning rate is 60 percent. 

 
D. eASCTrendTS Execution Methods 

Two different methods for executing trades can be used with eASCTrendTS signals: (1) 
Entry at Bar Close (EBC) and (2) Dynamic Execution. Only the first method is 100 
percent mechanical. The second method leverages traders’ discretion in their real-time 
execution of the eASCTrendTS signals to get better results.  Neither of these two 
methods of trading is the same as the Hybrid Trading Method discussed in Part Two. 

EBC Execution 

Entry at Bar Close (EBC) Execution is the simplest approach to using eASCTrendTS. 
Based on the parameters you choose, the system generates buy and sell signals. By 
waiting until the bar closes to enter a trade, you have 100 percent RTSA by definition, 
and you therefore avoid the uncertainties associated with the real-time signals. With this 
approach you simply issue buy or sell orders at the close of bars according to the trading 
signals issued by eASCTrendTS. Although you will know about the buy/sell signals 
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before (sometimes a long time before) the bar closes, you will wait until the bar closes to 
execute your order. EBC is a simple and 100% mechanical approach. These fully 
mechanical signals can be used by Autopilot Order Execution (AOE) (discussed in 
Section H below) to execute orders automatically.  

Another advantage of EBC execution is that since it is 100% mechanical, you can allow 
your position to run free without placing stops, provided you have the discipline to 
execute the buy and sell signals as they present themselves. By executing the signals on 
presentation at the end of bar close, the most damage that can be done to your trade 
equity is the loss your position may incur during a single bar. This is why you can trade 
without stops – your risk is controlled at the same time. An advantage of not using stops 
is that you avoid being stopped out of trades prematurely as a result of normal market 
fluctuation that could give rise to false hits as the market retraces prior to proceeding 
once again in your direction.  

Some traders prefer to enter trades at the open of the next bar. The long-term back-testing 
reports show that bar open execution and bar close execution yield the same results. 

The downside of using the EBC execution method is that fill prices for your orders are 
often less optimal due to signal slippage – the slippage between the real-time TS 
triggering price, and the price when the bar closes.  

Although the EBC execution method can be applied to charts using any time intervals, it 
has proven to be more effective on charts with intervals of 30 minutes or above. 

The Auto Order Execution (AOE) optional feature can only be used with EBC execution. 

Dynamic Execution 

Dynamic Execution allows you to enter trades based on the real-time signals before the 
bar closes or at bar close according to the following guidelines.  

1. After a long period of consolidation (a triangle pattern ending in flat prices and 
low volume), take the trade aggressively if it is a "sure"(that is, relatively stable) 
TS in the early stage of the bar formation.  

2. Take the trade if the TS is stable and 80 percent of the bar time has elapsed.  

3. If the signal is unstable (appearing and then disappearing several times), wait for 
the bar close to enter a trade. 

The Dynamic Execution method will result in better order fills but you need to have the 
experience to deal with the uncertainties of the real-time signals. Since you enter a 
position before the bar close, you are holding a so-called real-time position. You need a 
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way to protect the real-time position since the real-time TS has a potential to reverse. You 
can place a very tight stop order to protect the real-time position. This, however, may 
have an adverse effect on your trading performance by causing you to be stopped out of 
some trades prematurely. 

The Dynamic Execution method requires more attention and experience on the part of the 
trader than does the EBC execution method. A trader must have strong discipline to be 
successful when applying the Dynamic Execution method. Practicing with Virtual Paper 
Trading can help you improve your skill. (See Section F on Virtual Paper Trading in Part 
Two – The Hybrid Trading Method.) 
 
In order to trade according to a reliable signal and retain as much profit as possible when 
using this execution method, the RTSA should be configured to be at least 60 to 80 
percent or higher. Please use Scan DEV (see below) to find the appropriate values for 
DEV and RTSA.  

E. Overview of TS Functions 
As we discussed in Section C, in eASCTrend version 6.0, the classic eASCTrend 
indicators along with certain trading rules are integrated into a single trading signal called 
eASCTrendTS. This one mechanical buy/sell signal eliminates the need for further chart 
interpretations or trading rules. TS is mechanical and  confirmation of its settings comes 
from back-testing, which is performed by the system outside the trading session. 
Therefore, there is no need for traders to recalibrate these settings. The eASCTrendTS 
signal pinpoints the exact entry and exit points for trading. Because eASCTrendTS is a 
purely mechanical system based on a single signal, it is very easy to learn and use, even 
by traders who are new to the market or new to ASCTrend technology. 

This section looks in greater depth at the basic eASCTrendTS functions and how to use 
them. We’ve already looked at some of these functions, but this section provides a 
complete summary. To access all these functions, first click on , the “Rainbow” 
button on the toolbar. This opens the Format Trade Signal for Active Chart dialog box. 

In the dialog box, you will see the following functions that are available in 
eASCTrendTS: 

• Input Parameters  
• Mini Report  
• Scan TSPC  
• Best DEV  
• Scan DEV  
• Entry at Bar Close  
• Enable Alert  
• Exit Rules  
• Format Plot Style (Style, Color and Weight)  
• Reset eASCTrend Defaults  
• Save as Custom Defaults  
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• Reset to Custom Defaults  
 

F. In Depth Explanations of TS Functions 
 

1. Input Parameters 
The following eleven input parameters are displayed as a list in the Format Trade 
Signal for Active Chart dialog box: 

 
• TSPC – Trade Signal Performance Control is a key parameter for maximizing 

your results in different markets or at shorter or longer time intervals. You may 
select any positive integer, usually from 0 to 10 (although you may specify a 
number above 10 on occasion). A smaller number makes the system more 
sensitive and produces more trades. A larger number makes the system less 
sensitive and will produce fewer trades. The default TSPC value is 4. 
eASCTrendTS will automatically select this parameter, which you can change to 
fit your trading style using the assistance of the Scan TSPC function (discussed 
in item 3 below). 

 
• MONYRISK – This number is a unit number that when multiplied by the 

average recent 10-bar range determines the trailing stop algorithm. It is a setting 
of how far to place stops from the current symbol value based on the number of 
units a trader is willing to risk. The higher the value, the greater the risk. If the 
position profit is greater than the set MONYRISK, the software will start to 
tighten the protection stops accordingly, resulting in a trailing stop. The default 
value of 2.0 is the same as the MONYRISK value used in the eASCTrend 
indicators. Most traders do not adjust MONYRISK from the default value.  

 
• DEVIATION (DEV) – DEV makes a stop adjustment as a percentage of the 

symbol value. The default value is 0.0, and eASCTrendTS can automatically 
select this parameter for you. However, you may make minor changes to loosen 
or tighten the stops by setting DEV between -3.0 and 3.0 based on your risk 
tolerance and trading style. As DEV goes up, there is less chance of hitting stops, 
and therefore you will have fewer trades. However, if the market turns, you may 
give back some profit due to your relatively slower response to changing market 
conditions.  

 
• Nth Bar – After entering a trade, the number of the bar on which you will exit 

based on either the Nth bar exit rule or the Intelligent Nth bar exit rule (discussed 
in point 7, Exit Rules, below). The default value is 3 bars. This feature is very 
useful in choppy markets where it is important to act quickly. Using the Nth bar 
exit rule will help increase the system winning rate and overall AbleSys Index, 
but by leading to an automatic exit when the Nth bar is hit, it may reduce total net 
profits. Using the Intelligent Nth bar rule lets the system override the Nth bar exit 
rule and keeps you in a trade that is going well. 
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• ProfitLevel % – This very advanced feature is useful to traders who are in a 
profitable position, and who want to take advantage of real-time price fluctuation 
without running the risk of exiting prematurely. When the position gain (current 
price minus Entry Price) exceeds the ProfitLevel, the breakeven or real-time 
trailing stop algorithm exit rules become active. The default is 5.0 (i.e., 5.0% of 
the symbol value. The setting you use for ProfitLevel will depend on the symbols 
you trade and the intervals you use for the charts).  

 
• Trailing % – This is a real-time algorithm designed to take advantage of quick-

moving markets by setting appropriate exit points. It makes more refined 
decisions for real-time exits than those made by T2, T3, or T13. The default value 
for Trailing % is 100. You will get the most conservative back-testing reports 
with this setting. If you set it to 80% in trading, the real-time trailing algorithm 
will risk 20% of the position gain to capture even more profit in a quick-moving 
market. Note: The back-testing reports for non-100% trailing are for reference 
only. This is because the trailing algorithm is a real-time feature and the data feed 
vendors do not offer real-time price fluctuation information in historic data. This 
is why you can use 100% Trailing to obtain the most conservative back-testing 
reports, while setting it to 60%-90% in real-time trading. 

 
• ExitMA1 – Moving average period 1 for the Moving Average exit rule. The 

lower this number, the more closely the average follows the current symbol value. 
With a lower number, the average is more sensitive to price changes, resulting 
perhaps in more trades, but that are of less consequence. 

 
• ExitMA2 – Moving average period 2 for the Moving Average exit rule. ExitMA2 

is based on a longer period than ExitMA1, which means it gives a picture of the 
longer-term direction of the symbol. An exit signal will be triggered when the 
ExitMA1 and ExitMA2 values cross each other on the chart. 

 
• ContractSize – The number of shares or futures contracts you trade. For stock 

trading, use the actual number of shares that you normally trade, such as 500 or 
1000. For futures trading, use the actual number of contracts that you normally 
trade, such as 1 or 2. 

 
• PointValues – Dollar amount per unit, for common stocks = 1, S&P 500 futures 

= 250 (e-mini ES = 50), NASDAQ 100 futures = 100 (e-mini NQ = 20), T-Bonds 
futures = 1000, Crude Oil = 1000, Soybean futures = 50, and so on. The default 
value of 1 is always appropriate for stocks. For other markets, such as the Forex, 
this figure must be adjusted. To determine what the number should be, go to the 
Easy Reference section accessed from the Member Login area. Once you are 
logged in, click on the eASCTrend 6.0 Support link in the Support box just 
below the tabs. In the window that appears next, scroll down to the list of Easy 
References and then click on the eSignal Symbol Guide link. You can also 
access this area by clicking on Help in the menubar while  you are inside 
eASCTrend 6.0 program, and then selecting Support.  
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• CostPerTrade – Commission plus execution slippage cost, i.e., the difference 

between the value of the symbol at the time the signal is presented vs. your actual 
fill, per round-trip trade in dollars. If it costs $2.50 to buy one e-mini contract, 
then the round-trip commission is $5. If it costs $7.50 to buy 500 shares of a 
stock, then the round trip commission is $15. Add to the commission the expected 
slippage for the round trip to come up with the cost per trade. For example, if you 
expect the e-mini S&P to slip a quarter point, that is half a point or $25 per round 
trip. Add that to the commission and you have $30 for the cost per trade. If you 
expect a stock to slip one and a half cents, that is three cents per round trip or $15 
for 500 shares. Add that to the commission and you have $30 for the cost per 
trade. You must increase the cost per trade if you have higher commissions or 
higher slippage. Also, you may increase the cost per trade if you would like more 
conservative results in back-testing. 
 
Note: you must enter valid values for ContractSize, Point Values, and CostPer 
Trade before you auto select values for TSPC and Deviation. 
 

2. Mini Report 
The Mini Report gives you a quick way to experiment with the settings of different 
parameters by back-testing your desired variations from the default values – and you 
can do this without ever having to leave the Format Trade Signal for Active Chart 
dialog window. 

Clicking   , the Mini Report icon, will display key system performance results in 
the Mini Report window. Among the items displayed are: Net Profit, Number of 
Trades, Winning Rate, Max Drawdown, Profit Factor, AbleSys Index, and Real Time 
Signal Accuracy (please note: This is the only place where you can see RTSA). To 
test your ideas, just replace the default numbers next to the different input parameters 
such as TSPC, MONYRISK, DEV, and so on, with numbers of your own choosing. 
Then re-click the Mini Report  icon and a new report of key system performance 
results is displayed, based on back-testing your new parameters.  

 
3. Scan TSPC 

Scan TSPC helps you determine the best figure to use for the TSPC parameter. To run 
the Scan TSPC function: 

a. Select the chart time interval manually, e.g., 30-minute or daily, in the 
Format Active Symbol Window. Mechanical settings are used for 
swing/position trading only. Multiple-year data is recommended for selecting 
the TSPC/DEV. If you trade markets with intervals smaller than 30 minutes, 
you don’t need to use Scan TSPC. Please just use the default setting for the 
Hybrid Trading Method, which is the TSPC number that appears in the 
parameter window when you first open the Format Trade Signal for Active 
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Chart window. These defaults are appropriate for any intervals, including 
very small intervals, such as 1 to 5 minute charts).  

b. In the Format Trade Signal for Active Chart dialog box, click the Reset to 
eASCTrend Defaults button. The default values of TSPC = 4 and Deviation 
= 0.0 will appear.  

c. Input ContractSize (typically 1 contract for futures or 1000 shares for stocks), 
PointValue (typically 250 for the S&P or 1 for stocks) and CostPerTrade 
(such as commission plus slippage, e.g., $100, etc.). Do not leave 
CostPerTrade at zero.  

d. Apply any exit rules (see below). 

e. Now you are ready to run Scan TSPC. Click   , the Scan TSPC icon, and 
the program will automatically calculate the most profitable TSPC for the date 
range you selected when you first created the chart. After performing the 
calculation, the software will automatically input the suggested TSPC value 
for you in the Parameters list.  

f. Click on  , the Mini Report icon, to display the result summary for your 
review.  

 
4. Best DEV 

The Best DEV function will auto-select the best pair of integers for DEV and TSPC 
for the most profitable result. 

To use the Best DEV function, check the Best DEV box in the Scan TSPC area; 
input start and end values for the DEV routine in the Scan Deviation area if you wish 
to expand the scope for scanning (or, more likely, simply use the default values of 
start –1.5, end 1.5); then click the  icon. Notice that you may change the start and 
end values to your preference, but the step value for Best DEV is always 0.1. The 
system will run to find the best pair (combination) of DEV and TSPC for the most 
profitable results. This is a two-dimensional process that will find the highest 
performance peak among many peaks. The Mini Report will display the best result, 
and the best TSPC and DEV will be input directly into the Parameter area of the 
Format Trade Signal for Active Chart dialog box. 

This function is only applicable if the chart intervals are 30 minutes or above. It is 
recommended that a trader use longer-term data such as multiple years.  

 
5. Scan DEV  

Traders who use the Dynamic Execution Method for entering trades will want to take 
advantage of the Scan DEV feature. Unlike the EBC approach, which is fully 
mechanical and uses Best Deviation, the Dynamic Execution Method is based on 
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real-time TS signals where execution occurs prior to bar close. This leaves the trader 
subject to the unstable TS signals associated with real-time data, a problem that is 
reduced by using Scan DEV to select the best value for DEV to produce the best real-
time signal accuracy (RTSA). As previously discussed, the main function of 
Deviation is to adjust both the number of trades triggered and the real-time signal 
accuracy. Please note that you need a relatively high RTSA to use the Dynamic 
Execution Method. Scan Dev is available only when Entry at Bar Close (EBC) is 
unchecked. 
 
Increasing the Deviation will loosen the position of stops, thereby reducing the 
number of trades and increasing the real-time signal accuracy.  
 
Decreasing the Deviation will tighten stops, thereby producing more trades and 
decreasing real-time signal accuracy.  
 
The Scan DEV function is designed to find the best Deviation value for a balanced 
RTSA and the most profit. 

• The following is the main guideline for selecting the Deviation parameter:  a 
larger TSPC is associated with a smaller Deviation, and a smaller TSPC is 
associated with a larger Deviation. For example, if TSPC = 8, then you might use 
DEV = -0.1. Inversely, if TSPC = 1, then you might use DEV = 0.5. The purpose 
of maintaining the inverse relationship is to avoid entering into choppy markets 
and to keep from overtrading.  

• Scan DEV is appropriate only if you are using the Dynamic Execution method, 
and you want to adjust RTSA while TSPC is fixed. 

To use the Scan DEV function:  

• Click  , the Target icon, which will run the Scan DEV routine. Review the 
results in the Mini Report.  

• Normally, a higher RTSA will sacrifice profits. Therefore, you might not want to 
adjust the DEV for the highest RTSA. RTSA from 60% to 80% is practical. See 
the following section about how to enter trades under such RTSA conditions.  

 
6. Entry at Bar Close 

With Entry at Bar Close (EBC) checked, which is the default setting for TS, the back-
testing reports will offer accurate simulation for the EBC 100% mechanical execution 
results. With EBC unchecked, the back-testing reports will give the simulation for the 
real-time TS signals, which are used for Dynamic Execution or Hybrid Execution 
Method (HTM).  
 
Note: The back-testing reports for real-time TS (EBC unchecked) are for reference 
only. This is because the TS signals with EBC unchecked are a real-time feature and 
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the data feed vendors do not offer real-time price fluctuation information in historic 
data. AbleSys uses RTSA to show the accuracy of this simulation. 
 

7. Enable Alert 
The Enable Alert option enables the delivery of buy/sell signals with sound alerts 
and an alert window that pops up on your computer screen. 

 
8. Exit Rules 

The eASCTrendTS default settings leave unchecked all the exit rule boxes. With no 
exit rules selected, you may simply follow the buy/sell signals of eASCTrendTS. This 
means that once you are in a market, you will be given buy and sell signals on an 
ongoing basis so that you will always have a position in that market, i.e., moving 
from long to short and back to long as the trend changes from one direction to the 
other. 

If you check one or more of the exit rules, the Auto Select functions will include your 
selected exit rules in the calculations. 

Because eASCTrend has been designed to be a universal trading system that fits the 
needs of all traders, all of the exit rules listed below are made available. You may find 
that only one or a few of the exit rules are useful to you given the characteristics of 
the market you are trading. You have the option of selecting exit rules for non-
symmetric entry and exit. Be aware that if you select certain exit rules, they may keep 
you from holding a position at times. Using exit rules may reduce your risk; however, 
because you may trade less, you may also sacrifice some profit. 

• Nth Bar: Exit on the Nth bar after entering a buy/sell position. Use the Nth bar 
exit mainly for choppy markets, such as the S&P futures daily chart. You need to 
input the appropriate “Nth bar” number in the input parameter window mentioned 
above. You can determine the best value of N through your own trial and error, 
using the back-testing report as a feedback mechanism to evaluate different 
settings. Use End of Bar Close execution.  

• Intelligent Nth Bar: Exit on the Nth bar in a choppy market, but stay on the trend 
and maintain the position in a trending market (a desirable approach in a mixed 
choppy/trending market). Bar close execution. 

• Green Bar: Exit on the Green bar under certain conditions. Bar close execution. 

• eASCTrend Stop: Exit when the eASCTrend Stop is hit. You can either place a 
limit order using the stop value (determined by consulting the Info Window to 
find the eASCTrend13—BuyStop/SellStop) of the previous bar (last closed 
bar/limit order needs an update whenever a change is made in stop value), or exit 
the position when you see the exit alert if you don’t like to place/update the limit 
order in advance. Real-time execution.  

• Moving Average: Exit on the cross of MA1 and MA2. Bar close execution. 
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• Break Even: Exit when the price returns to the Entry Price, having first reached 
the Trailing Profit Level Price (Entry Price plus Profit Level). Real-time 
execution. 

• Trailing Stop: This is usually a real-time feature depending on the options 
checked. It has the potential benefit of capturing more profit in a market making 
quick moves by risking a small percentage of the position gain. The algorithm 
will be triggered once the Trailing Profit Level Price (TPLP) has been reached. 
The real-time position gain is the difference between the latest Profit Peak and 
Enter Price. If you check this exit option, an exit alert will be issued when the 
price retraces a certain percentage (20% of the position gain if trailing is set at 
80%) from the Profit Peak. 
 
For example, if you enter at $100 and Profit Level is 4%, the TPLP will be $104. 
When the market reaches a new Profit Peak at 110, the difference between the 
latest Profit Peak and Entry Price is $110-$100 = $10. If the Trailing % is set to 
80%, the exit alert will be issued when the market pulls back to $108 (110-
10*0.2). This price ($108) is called Trailing Exit Price (TEP). If 100 is used for 
the trailing %, the alert will be issued right on TPLP. You should exit your 
position in real time when you see the exit alert. Or you can place a limit order in 
advance using the TPLP value in the Info Window in order to avoid slippage. 
Otherwise, whether you exit in real time or at the end of bar close depends on 
which of the following options are checked: 

o APL: Exit based on a computer-generated Automatic Profit Level. Profit 
Level in Parameters window is ignored. Execute in real time. 

o ATE: Exit based on a computer-generated Automatic Trailing Exit. Trailing 
% in Parameters window is ignored. Execute at bar close. 

o EBC: Back-testing with bar close price for trailing stop exit. Execute at bar 
close for trailing exits. Exit at bar close. 

o Re-enter: This option will issue a re-enter alert.  Execute at bar close. 

o Exit 1/2 Position at Trailing stop: Exit 1/2 position and hold the other half 
until the position reverses. 

• Day Trading Only will automatically exit all positions at market close. You will 
not hold any position overnight. The system will re-enter positions when market 
conditions continue at the opening of the next day.  

• Intra-Trade Risk Control Exit and Re-enter reduces the intra-trade drawdown 
in some markets. This exit should be executed at the end of the bar.  

• Extreme Intra-Bar Risk Control exits a losing trade when extreme market 
conditions are detected during the creation of a bar. This exit should be executed 
in real time.  
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Note: Back-testing reports for all real-time features are for reference only. Data 
feed vendors do not offer real-time price fluctuation information in the historic 
data. Real-time features cannot be simulated accurately with back-testing. 
 
 

9. Format Style: Color, Style, or Weight 
You can format plot color, style, or weight of the various features to change them 
from the eASCTrend defaults to suit your preferences. 

 
10. Reset eASCTrend Defaults 

Click the Reset eASCTrend Default button to restore all settings to eASCTrend 
defaults. 

 
11. Save as Custom Defaults 

After you finish formatting eASCTrendTS, you can click the Save as Custom 
Defaults button to save your changes as custom defaults. 

 
12. Reset to Custom Defaults 

Click the Reset to Custom Defaults button to restore all settings to your custom 
defaults. 

 
13. The No Trade Zone (NTZ) Feature  

When traders execute trades mechanically (buy, sell, exit) in choppy markets, they 
can experience drawdown. NTZ is the equity chart of the original signal chart. When 
applied, it serves as a filter that can be used in conjunction with the original chart to 
let you control the amount of drawdown. With NTZ applied, when the system sees 
that your account equity fluctuation in a particular symbol is too great, it will stop 
system trading for that symbol by ignoring buy and sell signals on the signal chart. 
When the system sees that it’s possible for you to start making money again, it signals 
you to re-enter that market, and it honors the signals once more. The procedure for 
using NTZ is as follows: 

 
a. You need to have at least one symbol chart with eASCTrendTS applied. EBC 

(Entry at Bar Close) must be checked. 

b. Open a new chart and check Filter Chart in the Format Active Symbol window. 

c. Choose the filter type for No Trade Zone.  

d. If there are two charts with eASCTrendTS, you may select which chart receives 
the filter. 

e. After the Filter Chart is created, eASCTrendTS must be applied to it using the 
eASCTrend default values for all parameters except TSPC, Contract Size, Point 
Values, and Cost Per Trade. 
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f. Contract Size, Point Values, and Cost Per Trade are set to the same values as 
the original chart.  

g. Entry at Bar Close (EBC) must be checked on both the original and the filter 
charts. 

h. Do not use any Exit Rules and do not check Best Deviation. 

i. Click on Scan TSPC ($) and then click on OK. The system will now determine 
the optimum NTZ setting for that symbol. 

You do not trade when the NTZ chart is in a no-trade position (bars are red), but you 
do enter both long and short positions as directed from the original chart for that 
symbol when the NTZ chart is in a yes-trade position (bars are blue). The Mini 
Report associated with the NTZ chart will also show total trade, long trade, or short 
trade profits. Since NTZ is an equity chart, the total “long trade” performance in the 
Mini Report represents the trading result if the NTZ trading method has been 
implemented. Please ignore total trade and short trade performance results since they 
are not relevant for the NTZ chart.  

Also, ignore the data on the line labeled Buy/Hold Profit in the Mini Report 
associated with NTZ chart because it is not related to your trading. Look at the Mini 
Report of the original chart for Buy/Hold Profit. 

 
14. First Hour Rule 

If you select First Hour Rule and Day Trading Only, eASCTrendTS may not give 
buy/sell signals during the first trading hour if the position changed from yesterday’s 
last position. 

 
15. 1st Hour Trend2 Rule 

If you select 1st Hour Trend2 Rule and also have eASCTrend2 on the same chart, 
when the new buy/sell signals in the first trading hour do not agree with eASCTrend2 
signals, eASCTrendTS will not give the buy/sell signals. 

 
G. TS Report  
 

eASCTrend 6.0 provides back-testing reports on the performance of the trading system. 
By clicking   , the Display Trade Signal Report icon in the toolbar, you will see the 
report. Here is the typical report format:  
 

Performance Summary 
(For Symbol from mm/dd/yy to mm/dd/yy) 

 
Total Net Profit    Buy/Hold Net Profit 
Total % Net Gain    Buy/Hold % Gain 
 
Max Draw Down    Buy/Hold Max Draw Down 
% Max/Avg DD vs. Net Profit  % Buy/Hold Max DD vs. Profit 
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Gross Profit    Total Trades 
Gross Loss     Winning Trades 
Avg win/Avg loss    Winning Rate 
Profit Factor    AbleSys/EXP Index 
 
Avg Winning Trade   Consecutive Winning Trades 
Avg Losing Trade    Consecutive Losing Trades 
Avg Trade     Avg Holding Bars 
Largest Winning Trade   Avg Winning Bars 
Largest Losing Trade   Avg Losing Bars 
 
 
Maximizing Total Net Profit is our goal in trading. Three key factors of a trading system 
will help us to reach this goal:  

(a) Winning Rate = (Winning Trades / Total Trades) • 100%. 
(b) Win/Loss Ratio = Avg. Winning Trade / Avg. Losing Trade. 
(c) Profit Factor = Gross Profit / Gross Loss. 

 
The AbleSys Index is an overall performance factor, which equals the product of (a), (b), 
and (c). That is, AbleSys Index = (a) x (b) x (c). 
 
If the AbleSys Index (or simply ABC Index) = 1.0, it means the trading system will just 
break even. ABC Index > 1.0 is a winning system. In the trading software industry, ABC 
Index > 1.2 means it is a tradable system. However, with eASCTrendTS, typically, look 
for ABC Index > 2.5 as your tradable system. Don’t trade any symbols or charts for 
which the ABC Index is less than 2.5, even when the symbols are your favorites. With 
experience and with highly leveraged instruments you may reduce this number slightly. 
 
 

H. Advanced Features of eASCTrend 6.0 – Options Available Only in the Deluxe Plus 
Module  

1. Money Management (MM) 

Money Management (MM) is a very important issue in trading. A good MM strategy 
can help a winning system make even more profit.  

However, MM is not a trading system. It cannot turn a losing system into a winner. 
Nor does MM deal with buy/sell/stop signals. It only calculates the appropriate size of 
trades (number of shares for stocks or number of contracts for futures or Forex) based 
on your current account equity (or balance). Therefore, you must first have a winning 
trading system in place, such as eASCTrend, as the basis to which your MM strategy 
is applied.  
 
AbleSys has made a state-of-the-art Money Management formula available as an 
optional add-on with the End of Day Deluxe and Real Time Deluxe Plus subscriber 
modules. The MM feature creates a decision tree based on your account balance and 
the margin requirements for your trading instruments, as well as your risk tolerance. 
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As your account balance increases or decreases with market conditions, and you 
move to different levels of the decision tree, MM tells you how many shares or 
contracts you should trade to maximize your profitability.  

To help you set up MM, AbleSys has also created an innovative Money 
Management Calculator that is associated with any chart for which MM is enabled. 
This tool puts information about your optimal trade size at your fingertips.  
These are the performance requirements your trading system must meet so that you 
can apply the MM strategy:  

• A winning system with ABC Index > 1.2.  
• Lower Max Drawdown (MDD) < 1/4 of initial account balance.  
• Higher winning rate > 60%. 
• Sufficient number of trades within a given time period based on a trader’s 

own preference. 

In this formula, the Net Profit value is not very important. As long as the system 
meets the above requirements, the MM strategy will significantly increase the net 
profit with a sufficient number of trades.  

Setting up MM involves a two-part procedure. For the first part you set up the MM 
Calculator. Begin by clicking on  , the rainbow icon. In the Format Trade 
Signal for Active Chart window that appears, select the Enable Money 
Management feature under the Advanced Features area at the right side of the box. 
Click on the Setting button, which is now active, and the Advanced Functions 
window will appear. 
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Enter the amount of money you have budgeted to trade in this symbol. Base your 
opening balance on the initial margin requirement (specified by your brokerage firm) 
and the Maximum Draw Down (MDD) (which you can find in the back-testing 
report). (Please make sure that the margin value you input is for each share of stock 
or for each contract. The Reserve Calculator, which is discussed below, will use this 
value, in conjunction with the Shares/Contracts Per Unit to determine the margin 
reserve you will need for each unit increase or decrease.)  

For example, if the initial margin requirement for the symbol you want to trade is 
$25,000, and the MDD is $10,000, you should plan an initial account balance of 
$40,000 or greater. Please note that the MDD is multiplied by 1.5 to ensure you have 
sufficient margin reserve in your account. The formula is: 

Start Balance = Minimum Initial Margin + 1.5 x MDD 
Next enter the Shares/Contracts per unit, which is the number of shares (for stocks) 
or the number of contracts (for futures) which make up a unit. This value will be used 
to calculate the real trading position size inside the MM Calculator.  

Then enter your Risk Increase Rate (RIR). RIR is the risk fluctuation associated 
with each unit position increase or decrease. It defines the dollar amount per unit by 
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which you need your account to grow before the Money Management program moves 
you to the next level of the Money Management decision tree. RIR equals the 
account equity increase for only the first step up in the decision tree. MM 
automatically calculates the increase in equity required to move up additional steps 
based on the RIR value and the number of units. RIR is commonly set to 1/2 the 
MDD. 

The Rate of Risk Decrease is defined as a percentage of RIR. By default this is set at 
50%. You can change this figure, but to be safe, always keep the Rate of Risk 
Decrease smaller than 100% of the RIR. Doing this ensures that you always scale 
back your market exposure (trading position size) faster than your rate of risk 
increase (RIR). 

Finally, go to the Reserve Calculator area of this window and click on  ,  the 
Reserve Calculator icon. Each cell of the Reserve Calculator will now be filled. 
The purpose of the Reserve Calculator is to help you budget your account for the 
money management strategies. Please make sure that no negative values appear in the 
Reserve column. Negative values in the Reserve column indicate that you are at risk 
of using up all your account reserve. In order to avoid this overly aggressive handling 
of your account, you have several options: you can either increase your initial account 
balance, or increase the RIR value (which slows down rate of risk increase from step 
to step in the decision tree), or decrease your Shares/Contracts per unit (which 
lowers margin usage, and therefore risk). By making adjustments like these you can 
ensure that the values in the Reserve column turn positive.  

Click OK in both the Advanced Functions window and the Format Trade Signal 
for Active Chart window, and you’re now ready to move on to the second part of the 
process, which is activating the MM feature. 

To use the MM feature, click on , the Money Management icon on the toolbar, 
and the MM Calculator will pop up. The first level in the MM Calculator presents 
the initial balance and the initial position size. When using MM, never trade fewer 
contracts or shares than this initial contract size.  

When your account balance increases to the Maximum Reached Equity listed for 
the second level, click on the plus sign (+) in front of the U on the second level. You 
will see a sub-chart with instructions concerning the number of contracts or shares to 
trade as long as you are at that level.  
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When your account balance increases to the next level, click on the minus sign (-) on 
the previous level to close that sub-chart. You will not return to that level again. Then 
click on the plus sign (+) in front of the U on the next level. You will see a sub-chart 
with instructions concerning the number of contracts or shares to trade as long as you 
are at that level. You never return to a previous level. As you trade at each level, 
follow the instructions in the sub-chart at that level until your account balance 
increases to the next level. Within the levels, the green u means the condition of the 
account is up and the red D means the condition of the account has declined. 

Important Note: If you select the Auto Order Execution module, the Auto 
Execution Contract Size is the actual trading size automatically filled in on the order 
entry form. Before each trade, you must double-check this number and adjust it if 
necessary to match the MM Calculator information. 

In the above example, the initial account balance is $50,000 and the trading size = 1 
contract. If the account balance increases to $53,000, you would click on the plus sign 
(+) in front of $53,000 and follow the instructions to trade two contracts. If the 
system is losing, but the account balance is still above $53,000, you would still trade 
two contracts. However, if the account balance drops below $53,000, you would trade 
one contract 

After the account balance increases to $59,000, you would click on the minus sign (-) 
in front of $53,000 to close that level and click on the plus sign (+) in front of 
$59,000 and follow the instructions to trade three contracts. If the system is losing, 
but the account balance is still above $59,000, you would still trade three contracts. 
However, if the account balance drops below $59,000, but stays above $56,000, you 
would trade two contracts. If the account balance drops below $56,000, you would 
reduce your trade to one contract. Once the account balance has reached $59,000 and 
then declines below $56,000 you trade only one contract. You do not trade two 
contracts until the account moves up above $56,000 again, even though originally you 
went to two contracts at the $53,000 level. Your increase is more cautious until you 
reach the original high.  
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2. Auto Order Execution (AOE) 
Auto Order Execution is available as an optional extra in the Real Time Deluxe Plus 
version of eASCTrend. Please note that for the AOE module to work properly, you 
must have the correct settings selected so that eASCTrend 6.0 can link with your 
brokerage trading account (please see the AOE installation instructions on the 
Member Login page of WWW.WINTICK.COM). 

When you are set up with the AOE mode, all the buy/sell signals in your chart will be 
sent to the AOE module for processing, and eASCTrend will automatically fill in the 
correct information on the order entry form for your selected "clients," such as 
Interactive Brokers, Coesfx, and so on. 

To begin, open the Format Trade Signal for Active Chart dialog window, place a 
check in the box labeled Enable Order Execution, and click on the now active 
Setting button. The Order Execution dialog box pops up.  

 

 
 

This dialog box uses the following terms: 

• Trading Methods:  
a. Full Autopilot –Program auto-fills and auto-submits orders. A trader must 

monitor the computer when Full Autopilot is functioning. New users 
should start with the Semi Autopilot until they are familiar with the 
system. 

b. Semi Autopilot – Program auto-fills order entry form; user needs to click 
Submit to send out the orders. 
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c. Manual – Program doesn’t fill or submit orders.  

d. All Trades – Enables auto order execution for all trades. 

e. Close Position – Enables the auto order execution for the next trade to 
only close the current position and stop trading. This option will not 
reverse your position. 

f. Long Trades – Enables long trades. 

g. Short Trades – Enables short trades. 

• Trading Symbol: This option allows the trader to trade a symbol other than the 
symbol of the chart that has been pulled up. For example, a trader who has pulled 
up a chart for the S&P 500 could use this feature to initiate automatic order 
execution for the e-mini. 

• Separate SHORT and SELL: This option is used for stock trading only. It is not 
applicable for futures trading. Here, SHORT means Sell Short stocks. 

• Account: Input account number. 

• Select Clients: Click on the drop-down selections; pick one of the order entry 
forms, such as InteractiveBrokers.com (IB). 

• Reset to eASCTrend Defaults 

• Save as Custom Defaults 

• Reset to Custom Defaults 

• Apply: Click on Apply to apply the settings for the active chart. 

 
A special note on resuming AOE after a service interruption: Occasionally a 
service interruption will occur due to a power outage, a NIC card failure, a network 
problem or a server problem, etc. AOE execution is very robust. The positions in your 
brokerage account will strictly follow the chart with AOE settings once the service is 
resumed.  

 
AOE has the capability to synchronize InternetBrokers.com (IB) positions to the chart 
position. Once you turn on AOE for a symbol chart, the IB position associated with 
the symbol will be exclusively controlled by AOE. For example, if you turn on AOE 
for your IBM chart in eASCTrend 6.0 with, say, 1000 shares, your IBM position in 
your IB account will be forced to follow the chart signals. If the signal is long/buy, 
the IBM position in your IB account will be long 1000 shares. If the signal is 
short/sell, the IBM position in your IB account will be short 1000 shares.  All the pre-
existing positions before the launching of AOE or any change of AOE settings will be 
appropriately adjusted in order to make sure that positions in your IB account will 
follow the charts in terms of the number of shares and long or short positions. If the 
current chart indicates that we should short 1000 shares of IBM, the IB account 
should have a short position of 1000 shares of IBM as a result of the AOE order 
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execution. It does not matter whether prior to initiating AOE you were long IBM for 
100 shares or 2000 shares, or short 400 shares. 
 
Your IB account can have both AOE-controlled and non-AOE-controlled positions at 
the same time. But one symbol can only have either an AOE-controlled or non-AOE-
controlled position, not both. Also, each eASCTrend 6.0 license can have only one 
AOE chart for any symbol.  
 

3. Instant Order Place (IOP) 
Instant Order Place offers a convenient way to manually augment the Semi 
Autopilot or Full Autopilot order execution. It works with the Automatic Order 
Entry (AOE), which is available as an option in Deluxe Plus, by allowing you to 
manually override the AOE signals in situations where you desire more control over 
a trade.  

To use this feature to enter an order manually, click on  , the Instant Order 
Execution virtual keyboard icon in the toolbar, to bring up the Instant Order Place 
dialog box.  

 
 

In the Instant Order Place dialog box, enter the price at which you want your order 
executed. Then place a check next to Manual Override, and enter the contract size or 
number of shares in the Size field. Now specify the type of order you want executed: 
Market, Limit, or Stop order. Click on Buy to manually enter a long position or exit 
a short position, or click on Sell to manually close a long position or enter a short 
position. With some trading platforms, you must click on Short to enter a short 
position; otherwise you can ignore the button labeled Short. The orders that are 
generated by the Instant Order Place window will be placed in the AOE module. 

 Depending on whether you have selected the “Semi Autopilot” or “Full Autopilot” 
setting, the AOE module will process your IOP orders accordingly. Where “Semi 
Autopilot” has been selected, while the correct information will have been entered 
into your order form by the system, you must transmit your orders yourself by going 
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to your brokerage window and manually entering your order. With “Full Autopilot 
selected, eASCTrend will transmit the order for you. 

When you close the Instant Order Place (IOP) window, a dialog box pops up, 
giving you the option to turn on or off the Enable Auto Execution setting (EAE 
status). The purpose of this window is to make sure the software understands your 
intention, while offering a convenient way to switch between manual and automatic 
order execution. Please refer to the following table to see how this works: 

 

EAE status before 
IOP 

Question upon 
leaving IOP 

Selection EAE status after 
IOP 

On You have turned 
OFF AOE.  

Are you sure? 

Yes 

No 

Off 

On 

Off You have turned 
ON AOE.  

Are you sure? 

Yes 

No 

On 

Off 
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Appendices 
 
Most traders will not need to refer to the technical information in these appendices. They are 
only placed here as a reference in the interest of completeness. 
 

Appendix A. Adjusting eASCTrend Indicators 
 
While it is not necessary to change the default settings of the eASCTrend indicators, 
subscribers have the option of customizing indicators if they think it will help them better 
fulfill their trading style.  
 

1. eASCTrend1 (T1)  
The RISK level of T1 can be adjusted from 1 to 10. A value of 1 is the most sensitive, 
with minimum delay in issuing signals, and 10 is the least sensitive. The default value of 
RISK is 3. Under normal conditions, the default setting should be your first choice. You 
may adjust the RISK level by clicking Format > Indicators. Select eASCTrend1 from 
the drop-down menu to format and change the parameters. RISK for T1 is very similar to 
TSPC for TS. 

 
You can format the weight of the bars on your charts from Format > Symbol (or simply 
click the  icon), and you may change the Weight of bars. The paint-bar color can be 
changed to your preference. Click Format > Indicators and click Color to change the 
color of the bars. Please note that if you change the color choices from their default 
colors, you must perform a ‘color translation’ when reading the AbleSys documentation. 
This documentation presumes you are using the default eASCTrend colors. Until you are 
experienced with the indicators, we suggest you do not change the colors of bars or 
indicators.  

 
There are a total of four signal display modes in T1. Details of the modes are listed 
below:  
 

a. ASCMODE 0 – Classical blue bars and red bars. 
b. ASCMODE 1 - Classical blue bars and red bars with Significant Trend Change 

(STC) signals. 
c. ASCMODE 2 - Classical blue bars and red bars with T1 Long Term signals (LT). 

This is the default mode. 
d. ASCMODE 3 – All signals of MODE 0, 1, and 2. 

 
2. eASCTrend2 (T2) and eASCTrend3 (T3)  
 

Adjust the RISK and MONYRISK 
 
RISK and MONYRISK are two inputs for the trend-stop indicators. Select T2 or T3 
from the Format > Indicators. You can change the RISK and MONYRISK parameters.  
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RISK 
eASCTrend provides flexibility. The RISK factor for both T2 and T3 can be adjusted 
from 1 to 10, with 1 being the most sensitive with minimum delay and 10 the least 
sensitive. The default value of RISK is 3. 
 
MONYRISK 
MONYRISK is an optional input for T2 and T3. This option affects the trend-stop values 
only. It does not affect the trend determination. A specific range unit for MONYRISK is 
used here. This unit varies with the volatility of the markets and is defined by market 
movement. When you change this input value, you can choose to loosen or tighten the 
stops. The amount of money at risk varies depending on the market. For example, 
MONYRISK 1.0 for common stocks means $1.00 per share; MONYRISK 1.0 for S&P 
500 futures means $250 per contract; MONYRISK 1.0 for currencies means $125,000 
per contract and MONYRISK 1.0 for T-Bonds means $1000 per contract.  
 
Why use this specific unit? To avoid the Symbol Universe Settings. There are over 
25,000 security symbols in the United States alone. It is hard to check and set up each 
symbol universe accurately and individually. Furthermore, when you use third-party data, 
different data venders use different symbol names and different units for the same 
security. Symbol Universe Settings become very complicated. 
 
The MONYRISK factor is applied to eASCTrend calculations only when the LONG or 
SHORT positions have profits. When profit is greater than the MONYRISK unit set, 
extra protection for the profit will be activated automatically. T2 or T3 TREND STOPS 
will start to tighten the stops. The MONYRISK will also affect the calculations for the 
low risk entry points. The default value of MONYRISK is 1.50 for T3 and 2.0 for T2 
respectively.  
 
In another words, after the profit for the position becomes greater than 1.5 times the 
average market movement, eASCTrend will begin to tighten stops. MONYRISK can be 
adjusted from 0.5 to 5.0. If you like to use Fibonacci numbers, you may use them as 
inputs, such as: 0.382, 0.618, 1.000, 1.382, 1.618, 2.000, 2.382, 2.618, and so on. 
 
If you do not want the MONYRISK option at all, simply input a large number, such as 
1,000,000. Under this 1,000,000-unit setting, T2 or T3 will follow only the market’s price 
projection in deciding stops. 

 
3. eASCTrendSig (TSig)  
 

a. TSig in Different Modes 
 

TSig will provide a buy signal with a big BLUE dot when buy conditions are met. 
The value of the big blue dot is the initial stop for the position. TSig will provide a 
sell signal with a big RED dot when sell conditions are met. The value of the big red 
dot is the initial stop for the position. There are seven signal modes in TSig. You may 
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select buy signal only, or sell signal only, or select both buy and sell signals. See the 
next section, Input Parameters of TSig, for more details concerning ASCMODE. 

 
b. Input Parameters of eASCTrendSig (TSig) 

 
From the Format menu, click Indicators…, and select eASCTrendSig. You may 
change the Parameters of eASCTrendSig. You can adjust the variables of RISK, 
MONYRISK, OFFSET, and ASCMODE.  

 
RISK 
 
RISK can be changed from 1 to 10, with 1 being the most sensitive setting with 
minimum delay, and 10 being the least sensitive. The default value of RISK is 3. It is 
recommended that you use the default value when you first start. You may choose to 
change values after you become familiar with the markets you are trading. 

 
MONYRISK 
The variables of MONYRISK affect the eASCTrend stop values only; they will not 
alter the trend determination. This option works in the same way as the MONYRISK 
for T2 or T3. See the corresponding section for MONYRISK. The default value for 
MONYRISK is 1.5. The default should be your first choice when you start; later you 
can adjust the value from 0.5 to 5.0. For those who like Fibonacci numbers, you may 
use inputs such as: 0.382, 0.618, 1.000, 1.382, 1.618, 2.000, 2.382, 2.618, and so on.  

 
OFFSET 
The default value of OFFSET is 1.0. When you choose a value of 1.0 for OFFSET, 
you accept the signals-defined market. Using OFFSET 1.0 means you choose the 
market self-defined dynamic factors. You may also loosen or tighten signal 
conditions by adjusting the value of OFFSET. OFFSET must be a positive number 
ranging from 0.3 to 3.0. 

 
The smaller the number, such as 0.3, the fewer trading signals will be generated, and 
the higher the accuracy. The bigger the number, such as 3.0, the more trading signals 
will be generated, and the lower the accuracy. The default value for OFFSET is 1.0. 
You should use the default value when you first start.  

 
ASCMODE 
For convenience and clarity in searching, you may choose different signal modes 
from the following seven signal modes in eASCTrendSig: 

 
1. ASCMODE 1: Classic eASCTrendSig BUY and SELL signals. 
2. ASCMODE 2: Classic eASCTrendSig BUY signals. 
3. ASCMODE 3: Classic eASCTrendSig SELL signals. 
4. ASCMODE 4: eASCTrendSig Long Term BUY and SELL signals. 
5. ASCMODE 5: eASCTrendSig Color Change BUY and SELL signals. 
6. ASCMODE 6: Signals of ASCMODES 4 and 5. 
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7. ASCMODE 7: All eASCTrendSig signals. 
 
 
4. Four Input Parameters 
There are four input parameters used by eASCTrend indicators: RISK, MONYRISK, 
OFFSET and ASCMODE. See the table below for the summary. 

 
 RISK MONYRISK OFFSET ASCMODE 

eASCTrend1 Yes No No Yes 
eASCTrend2 Yes Yes No No 
eASCTrend3 Yes Yes No Yes 
eASCTrendSig Yes Yes Yes Yes 

 
Here,  

Yes - the parameter is used by the indicator.  
No - the parameter is not used by the indicator. 

 
RISK can be changed from 1 to 10 to select its sensitivity; 1 is the most sensitive with 
minimum delay and 10 is the least sensitive. The default value of RISK is 3. 
 
MONYRISK is an optional input. This option affects the eASCTrend stop values only, not 
the trend determination. A specific unit, which is the average range of the last 10 bars, is used 
for MONYRISK. The default value for MONYRISK is 1.5 for T3 and 2.0 for T2. It can be 
adjusted from 0.5 to 5.0. Traders who like the Fibonacci numbers may try inputs such as: 
0.382, 0.618, 1.000, 1.382, 1.618, 2.000, 2.382, 2.618, and so on. 
 
OFFSET. The default value of OFFSET is 1.0. When you choose a value of 1.0 for 
OFFSET, you accept the signals-defined market. You may loosen or tighten signal conditions 
by adjusting the value of OFFSET. OFFSET must be a positive number ranging from 0.3 to 
3.0. 
 

The smaller the number, such as 0.3, the fewer trading signals will be generated, and the 
higher the accuracy. The bigger the number, such as 3.0, the more trading signals will be 
generated, and the lower the accuracy. You should use the default value (see above) when 
you first start.  

 
Default Setting of eASCTrend Indicators: 
 
Indicator Risk MONYRISK  OFFSET ASCMODE 
eASCTrend1 3 - - 2 
eASCTrend2 3 2.0 - - 
eASCTrend3 3 1.5 - 1 
eASCTrendSig 3 1.5 1 7 
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ASCMODE of eASCTrend Indicators 
 
 eASCTrend1 eASCTrend3 eASCTrendSig 
ASCMODE 0 Trend only – Blue and 

Red bars 
Stops only – Blue and 
Red dots 

 

ASCMODE 1 Trend plus STC (a) Stops plus BO (c) Classic Buy and Sell 
signals 

ASCMODE 2 Trend plus LCC (b)  Classic Buy signals 
only 

ASCMODE 3 All signals of 
eASCTrend1 

 Classic Sell signals 
only 

ASCMODE 4   LCC (b) 
ASCMODE 5   SCC (d) 
ASCMODE 6   Both LCC & SCC 
ASCMODE 7   All signals of 

eASCTrendSig 
 
DEFAULT ASCMODE = 2 ASCMODE = 1 ASCMODE = 7 
 

(a) STC – Significant Trend Change signals 
(b) LCC – Long Term Color Change signals 
(c) BO – Break Out signals 
(d) SCC –eASCTrendSig Color Change signals 
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Appendix B. Other Indicators in eASCTrend 

 
The following indicators can all be applied by clicking on the  icon in the tool bar, and 
selecting the desired indicator by checking its box.  
 
1. Moving Average 
 

A moving average (MA) is a price average calculated over a specified period of time. 
For example, a 10-bar moving average includes the prices of the last ten bars on a chart in 
its calculation.  It is one of the most commonly used trend-following indicators. 
The Moving Average indicator in eASCTrend is calculated by one of four methods 
(labeled 0, 1, 2, or 3) depending on the Type of analysis you select. The default for Type 
is 0, and the default value for Length is 10 bars. 

Type = 0   calculate using the Closing price 
Type = 1   calculate using the Opening price 
Type = 2   calculate using the High price 
Type = 3   calculate using the Low price 

 
Calculations: 

MA = (C1 + C2 + ….+ Cn) / N 
Where, 

MA = Value of Moving Average 
C1, C2,…Cn = Close prices of last N days (bars) 
N = Length to average 

 
Usage 
A moving average (MA) is the average of a market's closing prices over a defined 
period of time. For example, a 10-day moving average is an average of closing prices 
over a 10-day period. Moving averages will not indicate an imminent trend change, 
but will help you determine if an existing trend is continuing by measuring the current 
direction, or help to confirm that a trend reversal has taken place. A moving average 
is similar to a trend line except that the moving average curves with the movement of 
price.  It can also provide support and resistance levels.  

 
2. Stochastic 
 

The Stochastic oscillators indicate overbought and oversold areas in the market 
based upon momentum or price velocity. The Stochastic Classic indicator calculates 
the location of the current price in relation to its range over a period of bars. 
 
Calculations: 

Stochastics are made up of four individual calculations: FastK, FastD, SlowK, 
SlowD.  The core of the calculations is based upon the FastK value which is 
calculated in the following manner. 
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FastK(Length) = (C - L)/(H - L)*100  
Where  

L = Lowest Low of a specified period 
H = Highest High of a specified period 
C = Today’s Close 
Length = Specified period of time 

FastD is an exponential average of FastK. SlowK is also an exponential average of 
FastD. SlowK equals the FastD. SlowD is an exponential average of FastD. 

 
 Default Parameters 

eASCTrend uses Slow %D 
Price value is Close 
Length is defaulted to 10 
 

3. Volume 
 

The Volume indicator displays the trading volume for the current bar. The unit of volume 
for stocks is in millions of shares. Volume for index futures is counted by ticks (trades). 
The weight of the histogram bars cannot be formatted. The color of the histogram bars 
can be formatted. The Volume indicator is located by default in subgraph 1. However, 
you may move it to subgraph 2 or 3 if subgraph 1 is being used by other indicators. 
 

4. Exponential Moving Average 
 

The moving average may be the most widely used indicator. The Exponential Moving 
Average (EMA) indicator calculates and plots an exponentially weighted average of 
prices, specified by the Price input, from each of the most recent number of bars specified 
by the Length input. This method of calculating a moving average gives greater weight to 
the market’s most recent price activity, and a reduced weighting to older prices. (A 
simple moving average gives equal weight to all the prices in the series.) A moving 
average is generally used for trend identification. Attention is given to the direction in 
which the average is moving and to the relative position of prices and the moving 
average. Rising moving average values (direction) and prices above the moving average 
(position) would indicate an uptrend. Declining moving average values and prices below 
the moving average would indicate a downtrend. A displaced moving average plots the 
moving average value of a previous bar or later bar on the current bar. This indicator is 
NOT displaced by default. Changing the input Displace to a positive number displaces 
the plot to the left. Changing the input Displace to a negative number displaces the plot to 
the right.  

 
Calculations: 

EMA = (Close[0] x Exp%) + ( EMA[1] x (1-Exp%) ) 
Where, 

EMA = Value of Exponential Moving Average 
Close[0] = Today’s Close price 
Exp% = The chosen exponential percentage 
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EMA[1] = Yesterday’s EMA value 
 

Default Parameters 
Default value of Length is 10.  
 

Usage 
The EMA is designed to solve both the problems of time lag with the simple average, 
and the diminished importance of the past with weighted average. It is the most 
sophisticated of the three types of averages. 
 

5. MACD 
 

Moving Averages are trend-following indicators that don’t work well in choppy markets.  
Oscillators tend to be more responsive to choppy markets. The Moving Average 
Convergence Divergence (MACD) indicator combines the best characteristics of both. 
MACD, which was first developed by Gerald Appel, is basically still a trend-following 
indicator.  
 
Calculations: 

MACD = EMA1 – EMA2 
Where, 

MACD = Value of Moving Average Convergence Divergence 
EMA1 = Fast Exponential Moving Average 
EMA2 = Slow Exponential Moving Average 

 
Default Parameters 

Price value is Close 
Length of EMA1 is 12 
Length of EMA2 is 26 

 
6. PercentR 
 

Percentage Range (PercentR) is essentially a technique for determining oversold and 
overbought signals in trading. The study uses the price range over a given period of time 
to establish a normal trading range. It then identifies occurrences of prices outside this 
normal trading range. PercentR is a numeric value containing the current %R value.  
 
Calculations: 

%R=100*((Hr-C)/(Hr-Lr)) 
Where 

r = The time period selected 
Hr = The highest High of that period 
Lr = The lowest Low of that period 
C = Today’s Close 

 
The period should be at least five trading days, and half the length of an identifiable 

© Copyright 2000-2006 by AbleSys Corporation. All rights reserved. 76 



market cycle. The more volatile a market, the shorter a period traders will want to use for 
their range. The period will vary with each trader’s market time frame. For a market of  
average volatility, a good period would be ten days.  

 
The parameter LENGTH can be hard coded with a whole number, or it can be replaced by a 
numeric simple input whose default value is a whole number. 
 
7. Relative Strength Index 
 

The Relative Strength Index (RSI) indicator is used in non-trending markets to identify 
tops and bottoms, buy and sell opportunities, and market extremes (overbought / 
oversold). 
   
The RSI is an oscillator with values ranging from 0 to 100. Many consider 50 to represent 
the RSI "zero line." Many analysts draw support and resistance lines based on RSI 
calculations. Divergences between the RSI and price can also indicate certain market 
conditions. 
 
The RSI indicator calculates a value based on the cumulative strength and weakness of 
price, specified in the input Price, over the period specified in the input Length.  For that 
number of bars, RSI accumulates the points gained on bars with higher closes and the 
points lost on bars with lower closes. These two sums are indexed, with the index plotted 
on the chart. The RSI plots as an oscillator with a value from 0 to 100. The direction of 
RSI should confirm price movement. For example, a rising RSI confirms rising prices.  
 
RSI can also help identify turning points when there are non-confirmations or 
divergences.  For example, a new high in price without a new high in RSI may indicate a 
false breakout.  RSI is also used to identify overbought and oversold conditions when the 
RSI value reaches extreme highs or lows. This indicator automatically changes the color 
of the RSI plot when it exceeds either of the levels specified in the inputs BuyZone and 
SellZone. Horizontal reference lines are also plotted at these levels as visual aids.  
 

8. Weighted Moving Average  
 

The moving average may be the most widely used indicator. The Weighted Moving 
Average (WMA) indicator calculates and plots a weighted average of prices, specified by 
the Price input, from each of the most recent number of bars specified by the Length 
input. This method of calculating a Moving Average gives greater weight to the market’s 
most recent price and a reduced weighting to older prices. (A simple moving average 
gives equal weight to all the prices in the series.)  
 
A moving average is generally used for trend identification. Attention is given to the 
direction in which the average is moving and to the relative position of prices and the 
moving average. Rising moving average values (direction) and prices above the moving 
average (position) would indicate an uptrend. Declining moving average values and 

© Copyright 2000-2006 by AbleSys Corporation. All rights reserved. 77 



prices below the moving average would indicate a downtrend. A displaced moving 
average plots the moving average value of a previous bar or later bar on the current bar.  
 
This indicator is NOT displaced by default. Changing the input Displace to a positive 
number displaces the plot to the left. Changing the input Displace to a negative number 
displaces the plot to the right.  
 
Calculations: 

WMA = (Close[0] x Exp%) + ( EMA[1] x (1-Exp%) ) 
Where, 

EMA = Value of Exponential Moving Average 
Close[0] = Today’s Close price 
Exp% = The chosen exponential percentage 
EMA[1] = Yesterday’s EMA value 

 
The default value of Length is 10. 

 
Usage 

In addition to the simple moving average, or a 2- or 3-line moving average, you can 
also apply a weighted moving average. This assigns more value to recent price data 
and lesser value to prices further back in time. The trend is considered to be up as 
long as the moving average line is rising along with the price. A close below could 
indicate a change in direction. A downtrend is considered to be continuing as long as 
the line is declining along with the price. A close above could indicate a change in 
direction. 

 
9. Bollinger Bands 
 

The Bollinger Bands indicator is a moving average presented as a pair of bands, one 
above and the other below the price bars on a chart.  The Bollinger Bands are calculated 
by one of four methods depending on the value of Price Type.  
 
Default Parameters 

Price Type is 0 
Length is 20. 
NumDevsUp is 2.0. 
NumDevsDn is -2.0 
Displace is 0 

 
10. Average Directional Index 
 

The Average Directional Index (ADX) is an oscillator with a range between 0 and 100. 
Low readings indicate a weak trend and high readings indicate a strong trend.  A high 
reading can indicate a strong downtrend as well as a strong uptrend.   
The default value of Length is 14. 
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Appendix C. Alert Sounds in eASCTrend 

 
Alert name Sound When it is heard 
eASCTrendTS Buy ding ding ding appearance of  large cyan/light blue dot 

on bar 
eASCTrendTS EBC Buy phone ring close of bar with large cyan/light blue 

dot 
eASCTrendTS Sell thud appearance of  large magenta dot on bar 

 
EASCTrendTS EBC Sell glass crash close of bar with large magenta dot 
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Appendix D. Traders Share Their Experiences Using eASCTrend 

 
• "With the experience as a floor trader, and after trying various trading software on the 

market during the last 35 years, I am using ASCTrend for my trading decisions. I have 
been using ASCTrend for almost four years. To place 50 S&P contracts on the market, I 
have to be really sure about the directions for my core positions. I depend on ASCTrend 
to detect the market directions. To be able to 'sit' on a substantial amount of positions is a 
difficult thing to do, but that’s where the big money is to be made."- J.B., Greensboro, 
NC 

 
• "I have been using ASCTrend since the beginning of 2001, making money in trading 

Mutual Funds, stocks, options, and day-trading the e-minis. I have tried many software 
programs since the late 80s and nothing has been as consistent as ASCTrend. While some 
software give ‘ratings’ on fundamentals and others curve fit the technicals, only 
ASCTrend gives me clear entries and exits with consistent results. I depend on 
ASCTrend for my entries and use ASCTrend stops to manage my trades after I open my 
trade. Both the entries and exits are very specific, making risk management very easy. 
ASCTrend is the only software that has provided me with a practical way of making 
money in trading regardless of the market or timeframe." - R.R., San Jose, CA 

 
• "I have been using ASCTrend since April 2003 trading e-mini S&P and making money. 

The eASCTrend training CD is especially helpful. The time I spent on studying the 
training CD is well worth the effort; it provides excellent modeling to take emotion (fear 
and greed) out of a trade, improves discipline in adhering to trading rules, and allows me 
to pick up the winning trades consistently." - E.M., West Point, NY 

 
• "eASCTrend 6.0 is the closest thing I have ever seen to a 'trend-predicting' program 

rather than a 'trend-following' program. Anyone can follow a trend after the fact; 
predicting a trend before the fact is quite another thing, but you have only to look at any 
trending chart equipped with AbleSys technology to see that eASCTrend 'never misses a 
big move.' Never. It's almost uncanny. It is a brilliant program designed and created by 
brilliant people. It is a benchmark. Thank you sincerely for sharing this wonderful 
technology with the investing public."- S.S., Hollywood, FL 

 
See more Testimonials online. 
 
THE ABOVE TESTIMONIALS WERE PROVIDED BY CUSTOMERS OF ABLESYS 
WITHOUT COMPENSATION. ABLESYS BELIEVES THEY ARE TRUE, BUT HAS 
NOT INDEPENDENTLY VERIFIED THEM NOR HAS ABLESYS ATTEMPTED TO 
DETERMINE THE EXPERIENCES OF THESE CUSTOMERS AFTER THE 
TESTIMONIALS WERE GIVEN. PAST RESULTS ARE NOT NECESSARILY 
INDICATIVE OF FUTURE RESULTS.  
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